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Power Analysis and Optimization Tutorial

This tutorial introduces the power analysis and optimization use model recommended for use with the
Xilinx® Vivado® Integrated Design Environment (IDE). The tutorial describes the basic steps involved in
taking a small example design from RTL to implementation, estimating power through the different
stages, and using simulation data to enhance the accuracy of the power analysis. It also describes the
steps involved in using the power optimization tools in the design.

- VIDEO: The Vivado Design Suite QuickTake Video: Power Estimation and Analysis Using Vivado

r“"'l shows how the Vivado Design Suite can help you to estimate power consumption in yourdesign
and reviews best practices for getting the most accurate estimation.

VIDEO: The Vivado Design Suite QuickTake Video: Power Optimization Using Vivado describes the

EI factors that affect power consumption in an FPGA, shows how the Vivado Design Suite helps to
minimize power consumption in your design, and looks at some advanced control and best
practices for getting the most out of Vivado power optimization.

Software Requirements

This tutorial requires the latest Vivado Design Suite software is installed. For installation
instructions and information, see the Vivado Design Suite User Guide: Release Notes, Installation,
and Licensing (UG973).

For hardware power measurement of 7 series devices, the tutorial requires Texas Instruments Fusion
Design Power Designer software, which can be downloaded from the following location:
http://www.ti.com/tool/fusion_digital_power_designer

For hardware power measurement of UltraScale™ devices, the tutorial requires Maxim Digital Power
Tool software, which can be downloaded from the following location:

https://www.maximintegrated.com/en/products/power/switching-regulators/MAXPOWERTOOL002.html
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Hardware Requirements

Supported Operating Systems to run the Vivado Design Suite, and memory recommendations when
using the Vivado tools, are described in the Vivado Design Suite User Guide: Release Notes, Installation,
and Licensing (UG973).

Hardware Requirements for 7 Series Devices
¢ The hardware power measurements for 7 series devices

(needed in Lab 3: Measuring Hardware Power Using the KC705 Evaluation Board), require a
Xilinx Kintex®-7 FPGA KC705 Evaluation Kit. You can find information on the Evaluation Kit at this
location:

Xilinx Kintex®-7 FPGA KC705 Evaluation Kit
e For power measurements through Tl Power Regulators

(needed in Lab 3: Measuring Hardware Power Using the KC705 Evaluation Board), use the Texas
Instruments USB Interface Adapter. You can find information on the USB Interface Adaptor at
this location:

www.ti.com/lit/ml/sllu093/sllu093.pdf

Hardware Requirements for UltraScale Devices

¢ The hardware power measurements in UltraScale devices
(needed in Lab 4: Measuring Hardware Power Using the KCU105 Evaluation Board), require a
Xilinx Kintex® UltraScale FPGA KCU105 Evaluation Kit. You can find information on the
Evaluation Kit at the following location:

Xilinx Kintex® UltraScale FPGA KCU105 Evaluation Kit

e For power measurements through Maxim Digital Power Tool
(needed in Lab 4: Measuring Hardware Power Using the KCU105 Evaluation Board), use the
Maxim Power interface adapter.
You can find information on the interface adapter at the following location:

https://www.maximintegrated.com/en/products/power/switching-regulators/MAXPOWERTOOL002.html
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Locating Tutorial Design Files

1. Download the reference design files from the Xilinx website:
ug997-vivado-power-analysis-optimization-tutorial.zip
2. Extract the zip file contents into any write-accessible location.

This tutorial refers to the location of the extracted ug997-vivado-power-analysis-
optimization-tutorial.zip file contents as <Extract Dir>.

ﬁ IMPORTANT: You will modify the tutorial design data while working through this tutorial. Use
a new copy of the original data each time you start this tutorial.

The ug997-vivado-power-analysis—-optimization-tutorial.zipfile includes a readme file
which contains the details and version history of the design files along with the folders of 7 series and
UltraScale design files.

7 Series Tutorial Design Files

You can find a separate 7 series folder containing the 7 series tutorial design files in the contents of the
zip file.

The following table describes the contents of the 7 series tutorial design files:

Directories/Files Description

/src Contains the design HDL and testbench for the functional
simulation.

/src/dut_fpga.v Top module for the design.

/src/bram_tdp.v Other design blocks - synthesized module.

/src/bram top.v
/src/dut.v

dut_fpga kc705.xdc Contains clocking and timing constraints for the design.

/src/testbench.v Testbench for simulating the design.

UltraScale Device Tutorial Design Files

You can find a separate UltraScale folder containing the UltraScale device tutorial design files in the
contents of the zip file.

The following table describes the contents of the UltraScale device tutorial design files:

Directories/Files Description
/src Contains the design HDL and testbench for the simulation.
/src/dut_fpga.v Top module for the design.
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Directories/Files Description

/src/dut.v
/src/Cascade bram.v
/src/Noncascade bram.v
/src/bram_top cascade.v Other design blocks.
/src/bram top noncascade.v
/src/bram _tdp cas.v
/src/bram_tdp noncas.v

dut_fpga_kcul05.xdc Contains clocking and timing constraints for the design.

/src/testbench.v Testbench for simulating the design.
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Lab 1: Running Power Analysis in the Vivado
Tools

Introduction

In this lab, you will learn about the Power Analysis and Optimization features in the Vivado® IDE. The
lab will take you through the steps of project creation and power analysis at the synthesis stage, using
the Vivado Report Power feature in vectorless mode. It will also demonstrate using the SAIF file
generated from behavioral simulation for Vivado Report Power Analysis.

You will analyze power in the Vivado IDE. Then you will examine some of the major features in the
Power Report window and closely examine some power specific Tcl commands. You will also learn to
create a SAIF file by simulating the design in the timing simulation stage using both the Vivado
simulator and Questa Advanced Simulator.

You will also learn how to achieve Power Optimization after opt _design in the Vivado IDE. You will
examine the power optimization report and selectively turn power optimizations ON or OFF on specific
signals, nets, modules, or hierarchy.

Step 1: Creating a New Project

To create a project, use the New Project wizard to name the project, to add RTL source files and
constraints, and to specify the target device.

Note: Throughout this tutorial, Xilinx® 7 series example design is used to explain the process of
configuring, implementing, estimating the power through different stages, and using simulation
data to enhance the accuracy of the power analysis. For UltraScale™ device design, most of the
steps are similar to 7 series. Additional information, wherever necessary, is provided for UltraScale
devices.

e On Linux,

1. Go to the directory where the lab materials are stored:

cd <Extract Dir>/7 series (for7 series devices)

or
cd <Extract Dir>/UltraScale (for UltraScale devices)

2. Launch the Vivado IDE: vivado
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File Flow Tools Window Help Q- Quick Access

VIVADO' & XILINX

HLx Editions

ALL PROGRAMMABLE.

Recent Projects

Q U |C k Sta rt Pf°je“-1

C:/Usersivenkatas/project_1
Create Project >

Open Project >

Open Example Project >

Tasks

Manage IP >
Open Hardware Manager >
Xilinx Tcl Store >

Learning Center

Documentation and Tutorials > v

Tcl Console

¢ Vivado 2018.1 - m} X

Figure 1: Vivado IDE - Getting Started Page

e On Windows,
3. Launch the Vivado IDE:
Start > All Programs > Xilinx Design Tools > Vivado 2020.x > Vivado 2020.x
(x denotes the latest version of Vivado 2020 IDE)
4. As an alternative, click the Vivado 2020.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation.

5. In the Getting Started page, click Create New Project to start the New Project wizard.

6. Click Next to continue to the next screen.
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¢ Mew Project

Project Name

Projectname: | power_tutorial1

v Create project subdirectory

Project will be created at: C:vivado_power_tutorial/power_tutoriald

Enter a name for your project and specify a directory where the project data files will be stored. ‘

Project location: | C:ivivado_power_tutorial IZ'

Figure 2: Creating a New Project

7. In the Project Name page, name the new project power tutorialland enter the project location
(C:\Vivado Power Tutorial). Make sure to check the Create project subdirectory option and

click Next.

8. In the Project Type page, specify the type of project to create as RTL Project, make sureto
uncheck the Do not specify sources at this time option, and click Next.

9. In the Add Sources page:
a. Set Target Language to Verilog and Simulator language to Mixed.
b. Click the Add Files button.

c. Inthe Add Source Files dialog box, navigate to the <Extract Dir>/7 series/src

directory for 7 Series devices or <Extract Dir>/UltraScale/src for UltraScale devices.

d. Select all of the Verilog (.v) source files, and click OK.

e. Inthe Add Sources page, change the HDL Source For the testbench. vfile to Simulation

Only.
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¢ MNew Project @

Add Sources

Specify HOL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new source ’
file on disk and add itto your project. You can also add and create sources later.

+,
Index Mame Library HOL Source For Location
w1 bram_tdpw  xil_defaulllic  Synthesis & Simulation = Civivado_power_tutorial/7_seriesisrc
w2 bram_topwv  xil_defaultlip  Synthesis & Simulation =  C:vivado_power_tutorial/y_seriesisrc
@3 duty ¥il_defaultlip  Synthesis & Simulation = C:nvivado_power_tutorial/7_seriesisrc
w4 dut_fpgaw ¥il_defaultib  Synthesis & Simulation = C:ivivado_power_tutorial/7_seriesisrc
w® 5 testbenchyv  xil_defaultlib  Simulation only *  Chivado_power_tutorial/7_seriesisrc
Add Files | | Add Directories | | Create File

Scan and add RTL include files into project
Copy sources into project

Target language: | Verilog w Simulator language: | Mixed w

Figure 3: Setting HDL Source Type for testbench.v (7 Series)

f.  Verify that the files are added and Copy sources into project is checked. Click Next.

10. In the Add Constraints (optional) dialog box, click Add Files and select dut fpga kc705.xdc in
the file browser. In the directory structure, you will find the dut fpga kc705.xdc file belowthe
/src folder.

For UltraScale devices, select dut fpga kcul05.xdc in the file browser. In the directory
structure, you will find the dut fpga kcul05.xdc file below the /src folder.

11. Click Next to continue.

12. In the Default Part dialog box, click Boards to specify the board for the target device and select
Kintex-7 KC705 Evaluation Platform for 7 Series or Kintex-UltraScale KCU105 Evaluation
Platform for UltraScale devices. Then click Next.
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Lab 1: Running Power Analysis in the Vivado Tools

TIP: When you specify a Board, you are also specifying the part you are targeting for your
design, in this case an xc7k325tffg900-2 FPGA for 7 Series or xcku040-ffva156-2-e FPGA for

UltraScale devices.

13. Review the New Project Summary page. Verify that the data appears as expected, per the steps

above, and click Finish.

Note: It might take a moment for the project to initialize in the Vivado IDE.

#  power tutoriall - [C:/vivado_power_tutorial/power _tutoriall/power_tutoriall xpr] - Vivado 2017.1 =N e |
File Edit Flow Tools Window Layout View Help Ready
=, >, LR - TN = Default Layout v
Flow Navigator E2 A PROJECT MANAGER - power_tutorial1 ? X
v PROJECT MANAGER 2
Sources 2 — B X Project Summary 200X
£ Settings ~
Qalz & + o :
Add Sources Settings  Edit
~ Design Sources (1
Language Templates > @& dut_fpaa (dut_fpaay) (1 Project name: power_tutorial1
ZF IP Catalog > Constraints (1 Project location: C:Nivado_power_tutorial/power_tutorial1
> Simulation Sources (1 Product family: Kintex-7
Vv IPINTEGRATOR Project part: Kintex-7 KC705 Evaluation Platform (xc7k325tffg900-2)
Create Block Design Top module name: dut_fpga
Target language: Verilog
Hierarchy | Libraries  Compile Order Sttt IngUage: | MEed
ign
Properties 2 — B X
v SIMULATION o BoartPart
Run Simulation Display name: Kintex-7 KC705 Evaluation Platform
Board part name: xilinx.com:kc705:part0:1.5
¥ RTCANALYSIS Connectors:
> Open Elaborated Design tto T D y path: R 17.1_daily_| 17. | files
URL: www.xilinx.com/kc705
Vv SYNTHESIS Board overview: Kintex-7 KC705 Evaluation Platform v
< >
P Run Synthesis
> Open Synthesized Desig Tcl Console Log | Reports | Design Runs 2 _00
Q = 2 + %
Vv IMPLEMENTATION
Name Constraints ~ Status WNS TNS WHS THS TPWS TotalPower FailedRoutes LUT FF BRAMs URAM DSP Stat Elapsed Strategy
P Run Implementation
v synth_1 constrs_1 Not started Vivado Synthesis Defaults (Vival
> Open Implemented Desig impl_1  constrs_1 Not started Vivado Implementation Default:
v PROGRAM AND DEBUG
i Generate Bitstream
> OpenHardware Manager < >

Figure 4: Project in Vivado IDE (7 Series)

14. In the Vivado Options dialog box (Tools > Settings > Tool Settings> Project), enter the tutorial

project directory in the Specify project directory box, so that all reports are saved in the tutorial
project directory. Then click OK.
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

s Settings (sl
Project
Project Settings Specify various settings related to projects. ‘
General T TS m e
Simulation Default Project Directory
Elaboration
Synthesis Start in directory (C./Usersivenkatas)
Implementation Last project's directory
Bitst
fistream Home directory (C:/Usersivenkatas)
» P
* Specify project directory: C:.fproj| IZ‘
Tool Settings
Project Target Language
IP Defaults
Source File * Verilog VHDL
Display
Recent
WebTalk
Help Reopen last project on startup
> Text Editor Mumber of recent projects to list 0 %
3rd Party Simulators
s Colars Mumber of recent directories to list: 15 :
Selection Rules Mumber of recent files to list 10 2
Shortcuts
Strategies

» Window Behavior

=
'\‘_?J_,' ‘ Cancel ‘ | Apply | ‘Bestore...

Figure 5: Setting the Project Directory

Now, the design is ready for Synthesis.
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Lab 1: Running Power Analysis in the Vivado Tools

Step 2: Synthesizing the Design

1. Click Run Synthesis in the Flow Navigator. In the Launch Runs Dialog box that appears click OK.

Ex5

¢ Launch Runs

Launch directory: | &0 =Default Launch Directory=

Options

#® Launch runs on local host:  Mumber of job

Generate scripts only

Dont show this dialog again

Launch the selected synthesis orimplementation runs.

s 4

y

b

Cancel

Figure 6: Launch Runs Dialog

Box

2. The Synthesis Completed dialog box appears after synthesis has completed on the design.

Synthesis Completed

o Synthesis successfully completed.

Next
BRun Implementation
@ Open Synthesized Design

View Reports

Dont show this dialog again

(]

Cancel

-

3. Open the synthesized design by selecting Open Synthesized Design in the Synthesis Completed

dialog box and clicking OK.

Power Analysis and Optimization
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

Step 3: Setting Up the Report Power

The Vivado IDE allows you to specify input data to the Report Power tool to enhance the accuracy of
the power analysis.

In the Vivado IDE, you can configure thermal, environmental, and power supply options to mimic the
board level settings as closely as possible. For information on setting these options, see the Vivado
Design Suite User Guide: Power Analysis and Optimization (UG907).

1. In the main menu bar, select Reports > Report Power.

2. Examine the Environment tab in the Report Power dialog box (Figure 8).
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

¢ Report Power @
Estimate power consumption based on the netlist design and part xcku040-ffival1156-2-e.
Results name: power_1
Environment  Power Supply Switching Output
Device Settings A
Temp grade:
Process: maximum w
Environment Settings
Output Load: 0 5| pF  [0-10000]
Junction temperature: 25679 °C
Ambient temperature: 25 2| C
Effective 3JA: 142 G/ [0-100]
Adrflow: 250 w | LFM
Heat sink: medium (Medium Prof... w
F5A "CMW [0-100]
Board selection: medium (107107) w
Mumber of board layers: 12to15 (12 to 15 Layer... w
+1B: “CMW [0-100]
< Firmed bn o em e E . 4nn , ~
Legend
User Defined Calculated Default
'i':?:' Cancel

Figure 8: Report Power Dialog Box (Environment Tab)
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Lab 1: Running Power Analysis in the Vivado Tools

3. In the Environment tab, set Process to maximum for a worst case power analysis. Examine the

Power Supply tab (Figure 9).

IMPORTANT: By default, Vivado Report Power uses nominal values for voltage supply sources.
Voltage is a large factor contributing to both static and dynamic power. For the most accurate
analysis, ensure that actual voltage values are entered for each supply. Similarly, ensure
temperature and other environmental factors match actual operating conditions.

¢ Report Power

Settings
Veeint:
Wecaux
Vecodsd:
Veocoz2h:
Vececol8:
Veecol15:
Weoco135:
Wecol12:
Vecauwx_io:
Vecbhram:
MGTAVECC:
MGTAW:
MGTVecaux

MGTZVecl:

Legend

User Defined

Results name:  power_1

Environment Power Supply

1.000

1.800

3.300

2500

1.800

1.500

1.350

1.200

1.800

1.000

1.000

1.200

1.800

1.075

L

AR (A [ || ] A (A Ak (A (4P
= = = = = = = = = =

ik
=

Calculated

Estimate power consumption based on the netlist design and part xc7vwd85tfg1157-1.

Switching | Output

0.970-1.030
[1.710-1.880]
3.000-3.450
[2.380-2.630
[1.710-1.900
[1.430 - 1.580]
[1.300 - 1.400]
[1.140-1.260]
[1.710-1.880]
0.970-1.030
[0.950 - 1.050
1.140 - 1.260
[1.710-1.880]
[1.050-1.100]

Default

=

Figure 9: Report Power Dialog Box — Power Supply Tab
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

4. In the Switching tab, expand Constrained Clocks and examine the constrained clocks in the design
(Figure 10).

IMPORTANT: Make sure all the relevant clocks in the design are constrained. All the design
clocks must be defined using create clock or create generated clock XDC
constraints, so that Report Power recognizes the clocks.

Default toggle rate is set to 12.5% and Default Static Probability is set to 0.5. This will be
applied to primary input ports (non-clock) and block box outputs.
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# Report Power @

Estimate power consumption based on the netlist design and part xc7k325tfFg200-2.

Lab 1: Running Power Analysis in the Vivado Tools

#
Results name:  power_1
Environment Power Supply Switching DQutput
Simulation Settings -~
Simulation activity file (.saif): | | ”Il
Default Activity Settings
Default toggle rate: 125 | [0-100]
Default Static Probability: 0.5 | [0.0-1.0]
Enable Rate Settings
Static Probability Toggle Rate
BRAM Port Enable: [0.0-1.0] [0 -100]
BRAM Write Enable: [0.0-1.0] [0 -100]
Bidi Qutput Port Enable: [0.0-1.0] [0 -100]
Toggle Rate Settings
Static Probability Toggle Rate
Primary Qutputs: [0.0-1.0] [0-100]
Logic
Registers: [0.0-1.0] [0 --100]
Shift Registers: [0.0-1.0] [0 -100]
Distributed RAMs: [0.0-1.0] [0 -100]
LUTs: [0.0 - 1.0] [0 - 100]
DSPs: [0.0 - 1.0] [0 - 100]
Block RAMS: [0.0 - 1.0] [0 - 100]
GTs
RX Data: [0.0-1.0] [0 --100]
TX Data: [0.0-1.0] [0 --100]
~ Constrained Clocks
Clock Period
sys_clk_in_p 5ns
clk_0 5ns
clkoutd 10 ns
@

Figure 10: Report Power Dialog Box — Switching tab expanded to display Constrained Clocks
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

5. In the Output tab of Report Power dialog box, specify the Output text file as power 1.pwr.

6. Specify the Output XPE file as power 1.xpe. After creating this file when Report Power runs,you
can import the file and results into the Xilinx Power Estimator (XPE). For information on importing
the file in to the Xilinx Power Estimator (XPE), see the Xilinx Power Estimator User Guide (UG440).

7. Specify the RPX file to write the results of the Report command in to the specified report file (RPX).
The saved RPX file can be reloaded using the Reports > Open Interactive Report command to
provide interaction/cross-probing with the open design.

# Report Power @

Estimate power consumption based on the netlist design and part xc7k325fg900-2.

Results name:  power_1

Environment Power Supply Switching Qutput
Qutput text file: power_1.pwr EI
Qutput XPE file: power_1.xpe EI
V| Output RPX file: | Cuprojipower_1.rpx |E|

Figure 11: Report Power Dialog Box (Output Tab)
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Lab 1: Running Power Analysis in the Vivado Tools

Legends in Report Power Tool

The following legends appear consistently in the Report Power tool:

Constraint

Simulation

User Defined

Estimated

Default

Displays when the Nets are defined as clock with timer constraints.
The defined frequency of a clock determines the switching activity.

Displays when the Nets with switching activities are derived from
simulation’s .saif file

Displays when the Nets with user set switching activities are
derived from set_switching_activity power tcl command.

Displays when the Nets with switching activities are generated by
report_power vectorless propagation engine.

Displays when the Nets include default switching activities. If you
use set_switching_activity on input port nets or on internal nets
before running report_power (vectorless propagation), the report
tool displays the default.

Step 4: Running Report Power

1. Click OK on the Report Power dialog box.

This runs the report power command.

2. Examine the Power Report power_1 generated in the Power tab of the results windows area inthe

Vivado IDE.

TIP: Due to continuous accuracy improvements in the Vivado tools, the actual power numbers
you see might be slightly different than the ones that appear in the following figures.
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Lab 1: Running Power Analysis in the Vivado Tools

Power

Seftings
Summary (1.379 W)
Power Supply
~ Ulilization Details
Hierarchical (0.9716 W)
Clocks (0.011W)
~ Signals (0.061
Data (0.061 W)
Clock Enable (0 W)
SetiReset (0W)
Logic (0.011 W)
BRAM (0.714 W)

WO (0.004 W)

Clock Manager (0.117 W)

Q = £ C W™

Summary

Power estimation from Synthesized netlist. Activity
derived from constraints files, simulation files or
vectorless analysis. Note: these early estimates can
change afterimplementation

Total On-Chip Power: 1.379W
Junction Temperature: 274°C
Thermal Margin: BT6°C (303W)
Effective 3JA: 1.8°C/IW

Power supplied to off-chip devices: 0W
Confidence level: Wedium

Launch Power Constraint Advisor to find and fix
invalid switching activity

On-Chip Power

67%

33%

Dynamic: 0.918W (6
Clocks:  0011W

Signals: 0.061W

Logic 0.0 W

M BRAM: 0714 W

W mmch: 0417 W

110: 0.004 W

Device Static: 0461W

T

? —-0a X

Figure 12: Power Report

3. Examine the power breakdown in the Power Report by block type (Logic, BRAM, 1/0, etc.).

4. Examine the power supply breakdown in the Power Supply view.

Power

Q

Settings

4L
Ll
Q
| 5

Summary (1.37

Power Supply

~ Utilization Details
Hierarchical (0.918 W

Clocks (0.0111
~ Signals |
Data (0 W
Clock Enable (
Set/Reset (0 W
Logic ( A

BRAM (
Clock Manager (0.117 W

0.71

Power Supply

Supply Source  Voltage (V)  Total (A)  Dynamic (A)
Vecint 1.000 1.041 0.745
Vecaux 1.800 0.152 0.067
Veeo33 3.300 0.042 0.000
Veeo25 2500 0.000 0.000
Vceo18 1.800 0.000 0.000
Veeco15 1.500 0.000 0.000
Veeo135 1.350 0.000 0.000
Veeco12 1.200 0.000 0.000
Vccaux_io 1.800 0.000 0.000
Vecbram 1.000 0.066 0.054
MGTAVce 1.000 0.000 0.000
MGTAVit 1.200 0.000 0.000
MGTVccaux 1.800 0.000 0.000
Vecade 1.800 0.030 0.000

Static (A)

0.296
0.085
0.042
0.000
0.000
0.000
0.000
0.000
0.000
0.013
0.000
0.000
0.000
0.030

Default

?2-0aX

Calculated

Figure 13: Power Report — Power Supply Display

5. Examine the Hierarchical breakdown of the power in the Utilization Details > Hierarchical view.
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Lab 1: Running Power Analysis in the Vivado Tools

Power
Q X 2 C W ” Q I Hierarchical
Settings Utilization

Summary (1.379 W

Power Supply v
~ Utilization Details > [ 0.079 W (6% of total)
ierarchical (0.918 W) > E0.079 W (5% of total

Clocks (0.011

0.079 W (6% of total

~ Signals (0.0 N
Data (0.061 W N
Clock Enable (0W N
Set/Reset (0 W 3
ic (0.011 W
S > E0.079W (5% of fotal
BRAM (0.7 -
> @0.079 W (6% of total
Clock Manager (0.117 W
> 0.079 W (6% of total
/O (0.004 W
1<0.001 W (=1% of total
0.124 W (9% of total)
power_1

Name

67% of total) 30 dut_fpga

ftotal dut (dut

gen_dut{0].br...
gen_dut[1].br...
gen_dut[2].br...
gen_dut[3].br...
gen_dut[4].br...
gen_dut{5].br...
gen_dut[6].br...
gen_dut[7].br...
gen_dut[8].br...
gen_dut[9].br...

Leaf Cells (5)
LeafCells (12

Clocks (W)  Signals (W) Data (W)
0.009 0.061 0.061
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006
0.001 0.006 0.006

Logic (W)

0.011
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001

BRAM (W)

0714
0.071
0.071
0.071
0.071
0.071
0.071
0.071
0.071
0.071
0.071

2 -0aXx
Clock Manager (W)  MMCM (W) /O (W)
<0.001 <0.001 <0.001
<0.001 <0.001  <0.001
<0.001 <0.001  <0.001
<0.001 <0.001 <0.001
<0.001 <0.001 <0.001
<0.001 <0.001 <0.001
<0.001 <0.001 <0.001
<0.001 <0.001  <0.001
<0.001 <0.001 <0.001
<0.001 <0.001  <0.001
<0.001 <0.001  <0.001

Figure 14: Power Report - Hierarchical Display

6. Examine the Clocks view and the various Signals views (Data, Clock Enable, and Set/Reset).

Power ?2 03X
Q X 2 C W7 Q T clocks [ Constraint Calculated
Settings Utilization Name Frequency (MHz) Buffer Clock Buffer Enable (%) Enable Signal BelFanout Sites Fanout/Site Type
Summary (1.3 ~ 10.011W (19 tal) 3 dut_fpga
Power Supply > 00.009W (1 T clkout0 100.000 N/A NA  N/A 842 611 1378 NA
 Utilization Details > 10.002W (<1% I clk_0 200.000 N/A NIA  NIA 2 2 1.000 N/A
Hierarchical (0.912 W/ > 1<0.001W (<1% of total o sys_clk_in_p 200.000 N/A NA - N/A 2 2 1.000 NA
locks (0.011 W)
~ Signals /
Data (0.061 W)
Clock Enable (0 W
Set/Reset (0 W
Logic (0.011 W
BRAM (0.71
Clock Manager (0.117 W
110 (0.004 W
power_1
Figure 15: Power Report - Clocks Display
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

Step 5: Viewing the Power Properties

This step will show you how you can get the display of static probability and toggle rate for a signal in

property window.

1. Note the total power (Total On-Chip Power) in the Power Report Summary view.
2. Click the Set/Reset item in the Power Report.

3. Click on the dut/dut_reset signal.

Power ? -0aX
Q T 2 C W 7 Q I setReset Attribute Estimated | | Calculated
Settings Utilization Name Signal Rate (Mtr/s) % High Fanout Slice Fanout Clock Logic Type
Summary (1.379 v oW 3 dut_fpga
Power Supply ow I dutidut_reset 0.000 0.000 530 0 clkoutd FFLUT
 Utilization Details ow I led_OBUF 0.000 100.000 3 0 clkoutd FFI/OLUT
Hierarchical (0.918
Clocks (0.011V
 Signals (0.061 V
Data (0.061V
Clock Enable (0
etReset (0 W)|
Logic (0.
BRAM
Clock Manager (0.117 W
1/0 (0.004V
power_1

Figure 16: Power Report - Set/Reset Display

4. Note that there is a Power tab in the Net Properties window, displaying Net Properties for the
dut/dut_reset signal. Click on Load Power Properties to get the power information the first time.

Net Properties ? -0 & X
I dut_reset o
Qutput

Togale rate: 00 %

Static probability: 0.0

Legend: Estimated

Edit Properties...

General Properties Connectivity Power  Aliases Cell Pins  Modes  Tiles Pip=s

Figure 17: Properties Window — Set/Reset Net Properties

5. Note the Toggle rate is 0% and the Static probability is O for the dut/dut_reset signal, which

indicates that Reset is always de-asserted in the design.
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v
iA Xl LI NX Lab 1: Running Power Analysis in the Vivado Tools

Step 6: Editing Power Properties and Refining the Power
Analysis

Assume the Reset is asserted for 10% of the cycles in this design. Switching activity can be set
accordingly to re-estimate the power.
1. In the Net Properties window, click the Edit Properties button.

2. In the Edit Power Properties dialog box, change the Toggle rate to 4% and the Static probability
to 0.1.

¢ Edit Power Properties @
Set power properties for dut_reset. ‘
Output
Toggle rate: 4000 2 %

Static probability: [0.0-1.0]

Figure 18: Edit Power Properties Dialog Box

3. Click OK.

4. In the Net Properties window, observe that the Toggle Rate and Static Probability values turn a
different color to indicate that they are user defined.
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Net Properties ? - 0aX
I dut_reset -3
QOutput

Toggle rate: 40 %

Static probability: 01

Legend: User Defined

Edit Properties...

General Properies Connectivity Power Aliases CellPins  Modes Tiles Pips

Figure 19: User Defined Color in Net Properties Window

You can also observe the equivalent Tcl command executed in the Tcl Console.

Tcl Console X Messages Log Reports Design Runs Power - oo
Q = s/l B B @
Command: report_power -file C:/Users/Xiinx/power_l.pwr -xpe C:/Users/Xiinx/power_l.xpe -rpx C:/proj/power_l.rpx -name power_ 1 e

Running Vector-less Activity Propagation...

Finished Running Vector-less Activity Propagation

0 Infos, 0 Warnings, 0 Critical Warnings and 0 Errors encountered.

report_power completed successfully

set_switching_activity -toggle_rate 4.000000 -static_probability 0.100000 [get_nets dut/dut_reset]

< >

Figure 20: Equivalent Tcl Command for Net Property Update

5. Rerun Report Power (Reports> Report Power).

6. Change the Output text File and Output XPE File in the Output tab to power 2.pwr and
power 2.xpe respectively.

7. In the Switching tab, set Switching Activity for Resets: to None. Then click OK.

8. In the Power window, note the change in total power reported in the power_2 report compared to
the power_1 report. The total power has decreased due to the change in the Signal Rate for the
dut/dut_reset signal. Since the signal is a reset signal, an increase in its activity will significantly
reduce the activity of other signals in the design. Note that the Signal Rate of the dut/dut_reset
signal is now color coded as being User Defined in both the properties window and the Set/Reset
view of the Power Report.
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Tcl Console Messages )g | Reporis | Design Runs | Power

Q| = & /C H QO X SsetReset User Defined Attribute
Settings Utilization Name Signal Rate (Mtr/s) % High Fanout Slice Fanout Clock Logic Type
Summary (1358 V v 1<0.001W (<1% of total 50 dut_fpga
Power Supply 1<0.001 W (1% of total) I dut/dut_reset 4.000 10.000 530 0 clkoutd FFLUT

 Utilization Details ow o/ led_OBUF 0.000 100.000 3 0 clkoutd FFIOLUT

Hierarchical (0.898 V
Clocks (0.011

v Signals (0.055
Data (0.055
Clock Enable (0

SetReset (<0.001 W)|
Logic (0.01

BRAM (0.7

Clock Manager (0.117

10 (0.004

power_1 X  power_2 X

22— v eI

Calculated

Figure 21: Power Report - User Defined Signal Rate

Xilinx recommends you to double-check the signal rates and percentage high (%high) values of high

impact 1/O ports, control signals (such as resets and clock enables) and high fanout nets. This is an

opportunity to guide the Report Power tool to the right estimation scenario.

See the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more information

on switching activity.

TIP: In Tcl, use the set _switching activitycommand to change the signal rate and static

probability of signals and use report switching activity to query the values that were
set on the signals.
set switching activity -signal rate 4 -static_probability 0.1 [get nets dut/dut reset]

report switching activity [get nets dut/dut_ reset]

IMPORTANT: Switching activity can also be specified in terms of toggle rate. Toggle rate is
always associated with a clock. The primary ports can be associated with a specific clock using
the set input delayand set output delay commands. If no clock association is found,
Report Power will associate the ports with respect to the capturing clock.

For a clock of 100 MHz and a toggle rate of 4, the equivalent signal rate will be 4 MTr/s
(signal_rate = toggle_rate * Freq = 4 * 100MHz ).
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Step 7: Running Functional Simulation with SAIF Output

Now that you have created a Vivado Design Suite project for the tutorial design, you can set up and
launch the Vivado simulator to run post-synthesis functional simulation. Simulation will generate a
switching activity values file (SAIF) that will enable you to do more accurate power estimation on your
design.

1. In the Flow Navigator, click Settings to open the Project Settings dialog box and set the simulation
properties in Simulation section.

2. In the Simulation section of Project Settings dialog box, note that the following Simulation defaults
are automatically set for you based on the design files:

Simulator language: Mixed
Simulation set: sim 1
Simulation top-module name: testbench

3. In the Elaboration tab of Simulation, make sure the xsim.elaborate.debug_level is set totypical,
which is the default value.
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o £y

¢ Settings @

Simulation
Project Settings Specify various settings associated to Simulation ‘
General
Simulation Target simulator: Vivado Simulator -
Elaboration . -
Synthesi Simulator language: Mixed ~
ynthesis
Implementation Simulation set: i sim_1 “
Bitstream _ )
s P Simulation top module name: | testbench II‘
Tool Seti v Clean up simulation files
ool Settings
Project
IP Defaults Compilation Elaboration Simulation Netlist Advanced
Source File
Displ xsim.elaborate snapshot
isplay
WehTalk xsim.elaborate. debug_level typical hd
Help ¥sim.elaborate relax v
s Text Editor ¥sim.elaborate. mt_level auto w
ard Party Simulatars ¥sim.elaborate. load_glbl b
s Colors ¥sim.elaborate.rangecheck
Selection Rules ¥sim.elaborate sdf_delay sdfmax hd
Shortcuts ¥sim.elaborate xelab.more_options
Strategies

L

Window Behavior

Select an option above to see a description of it

® o] [omm

Figure 22: Simulation Settings — Elaboration Tab

4. In the Simulation tab enter the SAIF file name as power tutorial func.saif for
xsim.simulate.saif. Observe that the xsim.simulate.runtime is 1000ns.

5. Click OK.
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¢ Settings

Project Settings

»

General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

IP

Tool Settings

w

w

With the simulation settings properly configured, you can launch the Vivado simulator to perform a

Project

IP Defaults
Source File
Display
WebTalk

Help

Text Editor

3rd Party Simulators
Colors
Selection Rules
Shortcuts
Strategies

Window Behavior

Simulation

Lab 1: Running Power Analysis in the Vivado Tools

Specify various settings associated to Simulation

Target simulator:
Simulator language:

Simulation set

Simulation top module name:

+'| Clean up simulation files

Compilation

Elaboratio

¥sim.simulate.tcl post

¥sim.simulate.runtime

Vivado Simulator -
Mixed ~
= sim_1 “
testbench E
1 Simulation Metlist | Advanced
1000ns

¥sim.simulate log_all_signals

xsim.simulate.custom_tcl

xsim.simulate.wdb

xsim.simulate.saif_scope

¥sim.simulate.saif

power_tutorial_func.saif

¥sim.simulate saif_all_signals

¥sim.simulate. xsim.more_options

xsim.simulate.saif

SAIF filename

DK ‘

‘ Cancel ‘ ‘ Apply | |Bestore...

Figure 23: Simulation Settings — Entering SAIF File Setting

post-synthesis functional simulation of the design.

Note: The power reporting and analysis are not performed at the RTL level. They are performed at

the gate level.
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6. In the Flow Navigator, click Run Simulation > Run Post-Synthesis Functional Simulation.

¥  SIMULATION
Run Simulation

Run Behavioral Simulation

Evd [
RTL ANALYSH Run Post-Synthesis Functional Simulation

> OpenElat Run Post-Synthesis Timing Simulation

» SYNTHESIS
P Run Synth_._

Figure 24: Running Post-Synthesis Functional Simulation from Flow Navigator

When you launch the Run Post-Synthesis Functional Simulation command, the Vivado simulator is
invoked to run the simulation.

SIMULATION - Post-Synthesis Simulation - Functional - sim_1 - testbench

Scope Objects Untitled 1

Q = = o Q -] Q W @ a [ « 4l T -]
Name Design Unit Block Type Name Value DataT. ” 1,000.000 ns|™
~ U testbench testbench Verilog M W sys_clk_p 0 Logic

> @ dut_fpga dut_fpoa Verilog M. @ sys_clk_n 1 Logic e m——————

@ alol albl Verilog M.. @ led 1 Logic

@ pass 1 Logic
> & WATCHDO.. 100000 Array

v
< >

Figure 25: Post-Synthesis Functional Simulation Window in the Vivado IDE

After the simulation completes, click x at the top right corner to close the simulation window.

Step 8: Incorporating SAIF Data into Power Analysis

The SAIF output file requested in the simulation run is generated in the project directory. To further
guide the power analysis algorithm we use this SAIF file.

1. Ensure the SAIF file requested is generated. Check to see that the SAIF file requested in the
simulation settings prior to running simulation appears in this directory:
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<project directory>/power tutoriall/power tutoriall.sim/sim 1/synth/
func/power tutorial func.saif

In the Flow Navigator window, click on Open Synthesized Design to expand options.
From the Synthesized Design options, select Report Power.

In the Report Power dialog box, set the Results name to power 3

AR R A

In the Output tab of Report Power dialog box, make the following changes:
o Set the Output text File to power 3.pwr
o Set the Output XPE File to power 3.xpe

6. In the Environment tab of Report Power dialog box, make sure that the Process is set to
maximum.

7. In the Switching tab of Report Power dialog box, specify the SAIF file location.

¢ Report Power 3

Estimate power consumption based on the netlist design and part xc7k325tTg900-2.

Results name: | power_3

wironment | Power Supply | Switching  Output

Reset switching activity before report power

Switching Activity for Resets: | MNone w

Simulation Settings

Simulation activity file (.saify { /sim_1/synthfuncipower_tutorial_func.saif E

Default Activity Settings
Defaulttoggle rate: 125 | [0-100]
Default Static Probability: 05 | [0.0-1.0]
Enable Rate Settings
Static Probability Toggle Rate
BRAM Port Enable: [0.0-1.0] [0-100]
BRAM Write Enable: [0.0-1.0] [0-100]
Bidi Output Port Enable: [0.0-1.0] [0-100]
Toggle Rate Settings
Static Probability Toggle Rate
Primary QOutputs: [0.0-1.0] [0-100]
Logic
Registers: [0.0-1.0] [O--100]
Shift Registers: [0.0-1.0] [0-100]

Plindribbnd D AR~ o 4m o 4nm

Figure 26: Specifying SAIF File Location
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8. Click OK in the Report Power dialog box.

The report powercommand runs, and the Power Report power_3 is generated in the Power tab
of the results windows area.

Power ?2-0aX
Q =/ s/ C H Summary
Settings . . ; o ;
Power estimation from Synthesized netlist. Activity On-Chip Power
Summary (1.332W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Note: these early estimates can Dynamic: 0.869 W
iiilatn Dataiis change after implementation.
Hierarchical (0.869 W Total On-Chip Power: 1332w - Clocks: 0.010 W
Clocks (0.0 Junction Temperature: 274°C Signalss 00w
e 5 Logic: 0.009 W
Signials 0.0 Thermal Margin: 57.6°C (303 W) & 9
Data (0.043 W BRAM: 0685W (79%
‘ Effective 9JA 18°CW i
Clock Enable : . . M MMCm: 0117W  (14%
3 Power supplied to off-chip devices: 0W
SetReset (<0 10: 0.005 W
Confidence level: High
Logic (0 g 35%
BRAM (0.535 W Launch Power Constraint Advisor to find and fix ] - —
. invalid switching activity Device Static: 0.463W (35%
Clock Manager (0. 117 W
1/0 (0.005 W
< » >

power_1 X power 2 X power_3

Figure 27: Power Report - Summary

Note: The SAIF annotation results are displayed in the Tcl Console. Make sure that all the design
nets are matched with simulation nets, to achieve better accuracy by including Simulation data.
For 7 series devices, the number of design nets and simulation nets may vary due to various
reasons. The most common reason s that their hierarchical separators are different. Sometimes,
the simulation nets may be lower down in the hierarchy level. However, they should match 100%.

Example: INFO: [Power 33-26] Design nets matched = 1894 of 1894

TclConsole x Messages Log Reports Design Runs | Power

Q| = I B B @

[E 33-330] 11 1 cl

INFO: [Power 33-177] SAIF annotation done from file C:/vivado_power_tutorial/power_tutoriall/power_tutoriall.sim/sim 1/synth/func/power_tutorial func.saif

INFO: [Power 33-26] Design nets matched = 1894 of 1894

report_power -file [C:/Users/Xiinx/power_3.pwr} -xpe {C:/Users/xiinx/power_3.xpe} -rpx {C:/proj/power_3.rpx} -name {power_ 3}

Command: report_power -file C:/Users/Xiinx/power_3.pwr -xpe C:/Users/Xinx/power_3.xpe -rpx C:/proj/power_3.rpx -name power_3
s b

0 Infos, 1 Warnings, 0 Critical Warnings and 0 Errors encountered.
report_power completed successfully

<

u ’

Figure 28: Tcl Console Log — Reading SAIF Data

9. Go to the I/0 view in the Power Report. Note that all the I/O port activity data has been set from

simulation data we specified. The data is color coded to indicate activity rates read from the
Simulation output file.
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Power ? -0axXx
Qi xz|s|CH Q| =|w c cal
Settings Utilization Name IO Type 1O Standard  Drive Strength  InputPins ~ OutputPins  Bidir Pins . Signal Rate...
Summary (1.332V ~ 10.005W (1% of total 5 dut_fpga
Power Supply 10.004 W (<1 & sys_ck_in_p  HP DIFF_SSTL... N/A 1 0 0 . 400.000
~ Utilization Details > 10.001W (<1 @ fmc_out HR LVCMOS33 12.000 0 10 0| 1.000
Hierarchical (0.859 W 1<0.001W (<1% < gpio_out_pass HR LVCMOS33 12.000 0 4 0 |- 1.000
Clocks (0.01 1<0.001 W (=1% oftotal) <@ led HP LVCMOS15 12.000 0 1 g |- 1.000
v Signals (0
Data (0.043 W
Clock Enable (<
Set/Reset (=
Logic (
BRAM (0.685 W
Clock Manager (0.117 W
/O (0.005 W)
power_1 X  power_ 2 X | power_3

Figure 29: Power Report - 1/0 Display

10. Note the difference in total power numbers (Total On-Chip Power in the Summary view) between
a pure vectorless run in the power_1 results versus with the post synthesis functional simulation
data in the power_3 results. Also note that the dut/dut_reset signal rates are overwritten by

simulation SAIF data.

Power ? —-0&aXx
Q=€ €W Q = SetRReset Simulation Calculated
Settings Utilization Name Signal Rate (Mir/s) % High Fanout Slice Fanout Clock  Logic Type
Summary (1.332V ~ 1<0.001 W (=1% of total 31 dut_fpoa
Power Supply 1<0.001W (<1% of fotal) I dut/dut_reset 1.000 26.250 530 0 clkoutd FFLUT
~ Utilization Details ow o[ led_OBUF 1.000 73.740 3 0 clkoutd FFIOLUT
Hierarchical (
Clocks (0.01V
v Signals (0.043 W
Data (0.043 W
Clock Enable (<0.001 W
Eetheset (<0M2
Logic V
BRAM (0.685 W
Clock Manager (0.117 W
110 (0.005 V
power_1 power_2 X  power_3 X
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Lab 1: Running Power Analysis in the Vivado Tools

Step 9: Implementing the Design

This tutorial helps you understand Power Analysis with and without Power Optimization. In this step,

you will run Implementation without Power Optimization.

1. In the Flow Navigator, right-click on Implementation and select Implementation Settings.

2. In the Opt Design settings, select the NoBramPowerOpt option for -directive and click OK.

»

w

»

i %
. o~
| g )

¢ Settings

Project Settings

General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

IP

Tool Settings

Project

IP Defaults
Source File
Display
WebTalk

Help

Text Editor

3rd Party Simulators
Colors
Selection Rules
Shortcuts
Strategies

Window Behavior

Implementation
Specify various settings associated to Implementation

Constraints

Default constraint set. | & constrs_1 (active

Options

+| Run report UltraFast methodology after routing

Incremental compile:

=)

Strategy: 4 Vivade Implementation Defaults* (Vivade Im... ~ |l
Description:
~ Opt Design (opt_design)
is_enabled +
tcl.pre E
tcl.post E
-verbose
-directive MoBramPowerOpt |
Mare Options Explare
~ Power Opt Desi { dess ExploreArea
r Opt Design (power_opt_design) -, o0 entialarea
is_enabled AddRemap
tcl.pre RuntimeOptimized |
ol ; MoBramPowerQOpt ]
clpos ExploreWithRemap
Maore Options Default
~ Place Design (place_design) -
-directive
Opt design directive.
0K ‘ ‘ Cancel ‘ ‘ Apply ‘ | Restore...

Figure 31: Disabling Power Optimization

3. In the Flow Navigator, click Run Implementation.
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4. When prompted to Save project before launching implementation click Don’t Save.
¢ Save Project @

e Save project before launching implementation?

Data to Save

+ | Bynthesized Design - constrs_1 - dut_fpga_kcV 05 xdc

o

Dont Save Zancel

Figure 32: Click “Don’t Save” Here

Conclusion

In Lab 1, you have learned how to set the power analysis in the Vivado IDE. In lab 2, you will learn
about the timing simulation and its effect on the power analysis.

Power Analysis and Optimization www.xilinx.com Send Eeedback
UG997 (v2020.1) July 8, 2020 I—\/_l

37


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&amp;docId=UG997&amp;Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&amp;releaseVersion=2018.2&amp;docPage=2
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2020.1&docPage=37

& XILINX

Lab 2: Running Timing Simulation and
Estimating Power

Introduction

In this lab, you will learn about generating a SAIF file after running a timing level simulation using the
Vivado® simulator and Questa Advanced Simulator. The lab will take you through the steps for SAIF file
creation, running timing simulation, and estimating power using the SAIF data.

Step 1: Configuring and Running the Timing Simulation using
Vivado Simulator

1. In the Implementation Complete dialog box, select Open Implemented Design and click OK to
open the implemented design. When prompted to Save project before opening an implemented
design, click Don’t Save.

Now you are ready to set up and launch the Vivado simulator to run post implementation timing
simulation. You will set the timing simulation properties in the Vivado IDE, then run the timing
simulation.

2. In the Flow Navigator, click Settings and select Simulation tab to set the timing simulation
properties.

3. In the Project Settings dialog box, note that the following defaults are automatically set:
Simulation set: sim 1
Simulation top-module name: testbench

4. In the Elaboration tab, make sure that debug_level is set to typical, which is the default value.

5. In the Simulation tab set the SAIF filename xsim.simulate.saif to
power tutorial timing xsim.saif.

6. Set the xsim.simulate.saif scope to testbench/dut fpga.
7. Observe that the simulation run time xsim.simulate.runtime is 1000ns.

8. Click OK.
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¢ Settings @

Simulation
Project Settings Specifyvarious settings associated to Simulation ‘
General
Simulation Target simulator: Wivado Simulator A
Elaboration
] Simulator language: Mixed w
Synthesis
Implementation Simulation set i sim_1 4
Bitstream . .
. Simulation top module name: | testbench E
: ¥ Clean up simulation files
Tool Settings
Project
IP Defaults Compilation Elaboration Simulation Netlist Advanced
Source File .
Display x¥sim.simulate.runtime 1000ns
WebTalk xgim.simulate log_all_signals* v
Help ¥sim.simulate. custom_tcl
5 Teuxt Editor ssim.simulate wdb
ard Party Simulators ¥sim.simulate. saif_scope testbenchidut_fpga
s Colors ¥sim.simulate saif* power_tutorial_timing_xsim.saif

RO S T T S T T S

Selection Rules

Shorcuts xsim.simulate.runtime
Strategies Specify simulation run time

> Window Behavior

':_'_?"::' | Cancel | ‘ Apply ‘ | Restare...

Figure 33: Timing Simulation Settings - Simulation Tab

With the simulation settings properly configured, you can launch the Vivado simulator to perform a
timing simulation of the post implemented design.

9. In the Flow Navigator, click Run Simulation >Run Post-Implementation Timing Simulation.

~  SIMULATION Net Properties
Run Simulation

Run Behavioral Simulation

~ RTLAMALYS ) ) ) )
Run Post-Synthesis Functional Simulation

> OpenElz o : ]
Run Post-Synthesis Timing Simulation
v SYNTHESIS Run Post-Implementation Functional Simulation
Run Post-Implementation Timing Simulation
P Run Synt - -

Figure 34: Running Post-Implementation Timing Simulation
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10. After the Vivado simulator has finished simulating the design, ensure that the SAIF file requested
has been generated. Check to see that the SAIF file requested in the simulation settings prior to
running simulation appears in this directory:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing xsim.saif

SIMULATION - Post-Implementation Simulation - Timing - sim_1 - testbench

Scope Objects Untitled 2
Q = = & Q # |Q W @ Q X « |4 M T o
Name Design Unit  Block Type Mame Valug DataT. ™ 1.000.000 ns|”™
~ 1 testbench testbench Verilog M % sys_clk_p 0 Logic

» 4 dut_fpga dut_fpga Werilog M... & sys_clk_n 1 Logic e ——,———

@ glbl glbl Werilog M... @ led 1 Logic

& pass 1 Logic
> & WATCHDO.. 100000 Array

Figure 35: Post-Implementation Timing Simulation using the Vivado Simulator
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Step 2: Running Report Power in Vectorless Mode

1. In the Flow Navigator, select Open Implemented Design > Report Power to open theReport
Power dialog box.

You can also select Reports > Report Power from the main menu bar.

2. In the Report Power dialog box Environment tab, make sure the Process is set to maximumand
click OK.

The Report Power command creates a Power Report under the power_1 tab in the results windows
area.

3. Note the total power (Total On-Chip Power) in the power report Summary page (Figure 36).

Power 2 _ 038 X%
- -~ »
Q x £ C Summary
Seftings .
o Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.545 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.080W (70%)
~ Utilization Details
Total On-Chip Power: 1.545W . -
Hierarchical (1.02 W) Junction T . — 21% Clocks:  0.022W (29
Clocks (0 - unction Temperature: : 70% Signals:  0.223W  (21%)
~ Signals (0.223 W) Thermal Margin: 57.3°C(30.1W) Logic: 0.009W 1%)
(0.223W) : g b)
Data (0.223 W) Bffective 34 18w WsRAM:  0T0SW  (65%)
Clack Enable (0W) Pawer supplied to ofi-chip devices: 0 W W UMCH:  0MTW (11%)

Confidence level: Medium 1o 0.004 W

Launch Power Constraint Advisor to find and fix 30%
invalid switching activty Device Static. ~ 0.4B5W  (30%)

O (0.004 W)

Figure 36: Running Post-Implementation Report Power in Vectorless Mode

Vectorless Analysis is done based on default switching activity specification on the primary ports and
the design clocks.

Refer to the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more
information on Vectorless Power Analysis.
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Step 3: Running Report Power with Vivado Simulator SAIF
Data

The project directory contains the SAIF output file requested in the previous timing simulation run. We
use this SAIF file — a "Switching Activity Interchange Format” file — to further guide the power analysis

algorithm.
1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, specify the SAIF file location in the Switching tab.
The SAIF file, which was requested in the simulation settings prior to running timing simulation,
should appear here:
<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing xsim.saif
3. Click OK in the Report Power dialog box.
After the Report Power command completes, the Power tab in the results windows area displays
Power Report power_2.
In the Tcl console, observe that the SAIF file is read successfully and that 100% of the design nets
are matched. This assures you that the generated SAIF file is correct and matched with all design
nets.
Power ? -0 X
Qa = &£ C 7 summay
Setings Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.485 W) derived from constraints files, simulation files ar
Power Supply vectorless analysis. Dynamic: 1.019W (69%)
~ Utilization Details "
Hierarchical (1049 W) Total On-Chip Power: 1485W 18% Clocks:  0.021W  (2%)
Clocks (0,021 W01 Junction Tem.perature: 276°C 59% Signals:  0A82W  (15%)
~ Signals (0182 W) Thermal Margin: 57.4°C (302W) Logic: 0.008W  (1%)
Data (0.182 W) Bifective 3JA 187w Ml cRaM:  0685W (57%)
Clock Enable (=0.00 Power supplied to off-chip devices: 0W B uncu 0417TW  (12%)
Confidence level: High o DO05W  (0%)
Launch Power Constraint Advisor to find and fix Sl
invalid switching acthity Device Static ~ 0466W  (21%)

<

Clock Manager (07117 W
110 (0.005 W)

»

impl_1(saved) X  power_1 X  power_2 X

Figure 37: Power Report with SAIF Data

4. Note the change in total power (Total On-Chip Power in the Summary view) in the power_2

report compared to the power_1 report. The total power estimated in the report generated with
SAIF file data will be different than the total power estimated in the vectorless run (power_1 results).

Examine the summary and block level (On-Chip Power) power distribution in the Summary viewof
the Power Report.
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6. Go to the Utilization Details > Signals >Data view in the Power Report. Note that all the Signal
Rate data has been set from simulation data the SAIF file provided.

The data is color coded to indicate activity rates read from the Simulation output file.

Power ? _0aXx
Q = &£ C ” Q I Data Simulation Calculated
Settings Utilization MName Signal Rate (Mir/s) % High Fanout Slice Fanout Clc
Summary (1.485 W ~ E0182W (1 ¥ dut_fpga =
Power Supply 010.001W (= I dutigen_dut[9] bram_top_instfaddr_a[1] 73000 B3935 34 34 ck
~ Utilization Details 10.001 W (=12 T dutigen_dut[9] bram_top_instiaddr_b[11] 73.000  36.049 4 34 ok
Hierarchical (1.019 W) 10.001W (= T dutigen_dut[1].bram_top_instbram_instmem_reg_2_0_i_2_n_0 74000 36.001 16 16 clk
Clocks (0.021) 10.001W (<1% T dutigen_duti9] bram_top_instibram_instmem_reg_0_0_i_3_n_0 73.000  36.011 16 16 clk
v Signals (0.132 W) 10.001 W I dut/gen_duti11bram_top_instiaddr_b[16] 732.000 £3.034 7 35k
Data (0.182 W) 10.001W (=1% T dutigen_duti8] bram_top_inst/addr_b[3] 73000 36.049 34 34 ok
Clock Enable (<0.00 10.001W (<1 73000 36.019 15 16 dk
_SEVRESE“{' oot 10.001W (= 72.000  36.000 16 16 ok
Logic 73000 63.934 34 34k
BRAN (0.0550 74000  36.001 16 16 clk
Clock Manager (0177 W
1O (0.005 I dutigen_dut[9] bram_top_instfaddr_b{0] 73000 B3934 34 34 ck
I dut/gen_dut{2].bram_top_instladdr_b{5] 73.000 63.936 kr ] 34 clk
[ c— > [ O ———— T T T — S——]
impl_1(saved) X  power_1 X power_2 X

Figure 38: Power Report Signals > Data View - Simulation SAIF Data for Signal Rates

7. In the Summary view of the power_1 report (the report generated by the vectorless analysis), click
on Confidence level (High in Figure 39).

The Confidence Level is a measurement of the accuracy and the completeness of the input data that
the Report Power uses while performing power analysis.
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Notice that the Confidence Level is High for the vectorless analysis since less than 25% of internal
nodes are user specified for Internal Activity.

Q T £ C7 summay

Power ? —-0aX

Settings .
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.545 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.080W  (70%)
~ Ltilization Details
Total On-Chip Power: 1.545W . (2
Hierarchical (1.02 ) 21% Clocks:  0.022W (29
Clocks (1 _ Junction Tem.p-erature. 2T7°C 70% Signals: 0.223 W
~ Signals | Thermal Margin: B7.3°C (30.1W) Logic: 0.000W
Effective SJA: 1.8 0w B BRAN: 0.705W )
Power supplied to off-chip devices: 0W M umcu: 0A1TW  (11%)
Confidence level: Medium o 0004 W
Launch Power Constraint Advisor to find ar Confidence Level Details >
invalid switching activity
Design State: High
Clock Manager (0.1 Design is routed
10 (0 ' Clock Activity: High
| < User specified more than 95% ofclocks
impl_1 (saved) >  power_1 X  power 2 X 110 Activity: High

User specified more than 95% of inputs

Internal Activity:
User specified less than 25% of internal
nodes

Characterization Data: High
Device models are Production

Figure 39: Confidence Level for Vectorless Power Analysis (power_1)

In the Summary view of the power_2 report (the report generated by the analysis for which you
specified a SAIF file as input), click on Confidence level (High in Figure 40).

Notice that the Confidence Level has increased to High, since more than 25% of internal nodes are
user specified for Internal Activity.
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Power ? 08 X
O T £ C7 summay
Settings ) ; . ;
Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.485 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.019W  (69%)
~ Utilization Details
Total On-Chip Power: 1485W . f LT
Hierarchical (1.019 ] 18% Clocks: 0.021W  (2%)
Clocks (0.021 ) Junction Tem.p-erature. 276 °C 59% Signals: 01B2W  (18%)
~ Signals (0.182 W) Thermal Margin: BT 4°C(302W) Logic: 0.008 W 1%)
Data (0.182 W) Effective 3JA 1.8 *CW W era: 0EBEW  (57%)
Clock Enable (= Power supplied to off-chip devices: 0W W vCh: 0A1TW  (12%)
SetReset (=00  Confidence level: High 1oy 0005W  (0%)
Logic (0.008 W) Launch Power Constraint Advisor to find 3 Confidence Level Details X
BRAM (0 625 W) invalid switching activity
- Design State: High
Clock Manager (0.1 Design is routed
IO (0.005W) Clock Activity: High
|- I N User specified more than 95% of clocks
impl_1 (saved) * power 1 X | power_2 ¥ 1O Activity: High
User specified more than 95% of inputs
Internal Activity: High
User specified more than 25% of internal

nodes

Characterization Diata: High
Device models are Production

Figure 40: Confidence Level for Power Analysis with SAIF Input (power_2)

Generating a SAIF File using Questa Advanced Simulator

The following steps will take you through the process of SAIF file creation, running timing simulation,
and estimating power using the SAIF data using Questa Advanced Simulator.

IMPORTANT: Make sure the Vivado Design Suite knows where to pick up the Questa Advanced
Simulator tool. You can either:
Manually set the path to ModelSim/Questa Advanced Simulator using the $PATHenvironment

variable
or

From the Tools > Settings > Tool Settings section, define the path to the simulator in the
Vivado IDE under the 3rd Party Tools tab: Questa Advanced Simulator install path.
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Make sure the Compiled library location points to a valid location for the compiled Xilinx
simulation libraries.

To create new compiled libraries:

1. In the 3" Party Simulators tab, specify the Compiled library location to Questa Advanced
Simulator. Use the Compiled library location specified during the compiled library generation and
enter it in the Compiled library location field of 3" Party Simulators tab. It should point to the
compile simlib directory.

2. Click OK to define the path and generate compiled libraries.

4 Settings @
3rd Party Simulators
Project Settings Specify install paths and default compiled library paths. Default compiled library path will be ‘
General applied only at new project creation.
Simulation ~
Elaboration Install Paths
Synthesis .
ModelSim: IZ'
Implementation
Bitstream QuestaSim: | Gigensys/gensys/guesta0.5ciwin32 ||Z|
>
I IES: E
Tool Settings
g ves: E
Project
IP Defaults Riviera: E
Source File ActiveHDL: E
Display
WebTalk Default Compiled Library Paths
Help
» TextEditor WodelSim: IZ'
3rd Party Simulators Questa: IZ'
» Colors
_ IES: E
Selection Rules
Shortcuts VCS: E
Strategies o
Riviera: E
» Window Behavior
ActiveHDL: E -
':f',:' ‘ Cancel | ‘ Apply ‘ | Restare...

Figure 41: Setting the Questa Advanced Simulator Installation Path and compiled libraries
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Step 1: Configuring and Running Timing Simulation in
Questa Advanced Simulator

Now you are ready to set up and launch the Questa Advanced Simulator to run post-implementation
timing simulation. You will set the timing simulation properties in the Vivado IDE, and run the timing
simulation.

1. In the Flow Navigator, right-click Simulation to select Simulation Settings. Set the timing
simulation properties.

2. In the Simulation Settings tab, set the Target simulator to Questa Advance Simulator.

3. Click Yes to change your target simulator to Questa Advance Simulator.

o

.

¢ Target Simulator @

o Cluesta Advanced Simulator requires that Xiling libraries are pre-compiled.
You can compile Xiling simulation libraries by going to tools menu and clicking
on compile simulation libraries. Make sure that the compiled library location
in simulation settings menu is pointing to the correct file. To confirm
the status of the compiled libraries run report_simlib_info Tcl command.

OK to change your target simulator to ‘Questa Advanced Simulator?

Figure 42: Simulation Settings — Changing the Target Simulator

4. Set the questa.simulate.saif to power tutorial timing questasim.saif.
5. Set the questa.simulate.saif scope to testbench/dut fpga.

6. Note that the questa.simulate.runtime is 1000ns.
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Simulation
Project Settings Specify various settings associated to Simulation ‘
General
Simulation Target simulator: Questa Advanced Simulator ~
Elaboration ) -
. Simulator language: Mixed iV
Synthesis
Implementation Simulation set: = sim_1 w
Bitstream
s 1P Simulation top module name: | testbench IZ‘
+'| Clean up simulation files
Tool Settings
Project Compiled library location: ifakashaftmp/Tutorialiread_saiflproject_3/project_3.cache/compile_simlib/questa B
IP Defaults
Source File
Compilation Elaboration Simulation Netlist Advanced
Display
‘ B s R
WebTalk questa.simulate.log_all_signals* '
Help questa.simulate.custom_do
» Text Editor .
questa.simulate.custom_udo
3rd Party Simulators
questa.simulate.custom_wave_do
» Colors
. questa.simulate.sdf_delay sdfmax
Selection Rules
uesta.simulate.ieee_warnings v
Shortcuts a — g
. . .
Strategies questa.simulate.saif_scope testbenchidut_fpga
questa.simulate.saif* power_tutorial_timing_guestasim{saif

» Window Behavior
questa.simulate.vsim.more_options

questa.simulate.saif*
Specify SAIF file

¢ Settings @

':"_?":' | Cancel | | Apply | | Restare...

Figure 43: Configuring SAIF file Settings

7. Click OK. With the simulation settings properly configured, you can launch the QuestaAdvanced
Simulator to perform a timing simulation of the design.

8. In the Flow Navigator, click Run Simulation > Run Post-Implementation Timing Simulation.
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SIMULATION Net Properties

Run Simulation

Fun Behavioral Simulation

v RTL AMALYS _ _ _ _
Run Post-Synthesis Functional Simulation

» Open Elz o _ _
Run Post-Synthesis Timing Simulation
v  SYNTHESIS Run Post-implementation Functional Simulation
Run Post-Implementation Timing Simulation
P Run Synt - g

Figure 44: Running Post-Implementation Timing Simulation

A separate Questa Advanced Simulator GUI opens and starts simulating the design.

9. After the Questa Advanced Simulator has finished simulating the design, make sure the SAIF file
requested has been generated. Check to see that the SAIF file requested in the simulation settings
prior to running simulation appears in this directory:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing questasim.saif

Step 2: Running Report Power in Vectorless Mode

IMPORTANT: If SAIF based report power has already been run in this session, run the
reset switching activity -allcommand in the Tcl Console. This will clear the SAIF
data in the power engine from the earlier runs.

1. Close any open Report Power views.

2. In the Flow Navigator, select Implemented Design > Report Power to open the Report Power
dialog box.

Alternatively, select Reports > Report Power in the main menu bar.
3. In the Report Power dialog box, make the following settings:
o Specify the Results name as power 1
o Inthe Environment tab, Set the Process to maximum
o Inthe Switching tab, leave the Simulation activity file empty

4. Verify that all the input settings are correct and click OK.
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The Report Power command creates a Power Report under the power_1 tab in the results windows
area. Note that the total power for Vectorless Analysis runs with default switching rates.

Lab 2: Running Timing Simulation and Estimating Power

Power
Q : : »
= v

Settings

Power Supply
~ Utilization Dretails
Hierarchical (1.019
Clocks (0.021 W)

~ Bignals (0.182
Data (0.182 W)
Clock Enable (-
SetReset (=0.0

Logic (0.008 W)
BRAM (0.685 W)

Clock Manager (0.1
I3 (0.005 W)

Summary

Power analysis fram Implemented netlist. Activity
derived from constraints files, simulation files or

vectorless analysis.

Total On-Chip Power:
Junction Temperature:
Thermal Margin:

Effective SJA:

Power supplied to off-chip devices:

Confidence level:

1485 W
276°C

57.4°C (30.2 W)
1.8°CW

ow

High

Launch Power Constraint Advisor to find and fix

invalid switching activity

2

On-Chip Power
Dynamic: 1019w (69%)
18% Clocks:  0.021W  (2%)
69% Signals:  0.182W (18%)
Logic: 0.008 W (1%)
B BRAM: 0.685W (67%)
W vmcu: 01M7W  (12%)
o: 0.005 W (0%)
31%
Device Static: 0466W (31%)

-0 a X

Figure 45: Power Report — Vectorless Mode Run
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Lab 2: Running Timing Simulation and Estimating Power

Step 3: Running Report Power with Questa Advanced
Simulator SAIF Data

The SAIF output file requested in the simulation run has been generated under the project directory.
We use this SAIF file — a "Switching Activity Interchange Format” file — to further guide the power
estimation algorithm.

1. In the main menu bar, select Reports > Report Power.

2. In the Report Power dialog box, specify the SAIF file location in the Switching tab.

The SAIF file, which was requested in the simulation settings prior to running simulation, should

appear here:

<project directory>/power tutoriall/power tutoriall.sim/
sim 1/impl/timing/power tutorial timing questasim.saif

3. Click OK in the Report Power dialog box.

The Report Power command runs, and the Power Report power_2 is generated in the Power tab of
the results windows area.

Q & c 7
Settings
Power Supply
~ Utilization Details
Hierarchical (1.019 W)
Clocks (0.021 W)
~ Signals (0.182 W)
Data (0,182 W)
Clock Enable (=0.00
SetReset (0W)
Logic (0.008 W)
BRAM (0.685 W)
Clock Manager (0117 W
10 (0.005 W)

power_2 *  power_1 X

Summary

Power analysis from Im

plemented netlist. Activity

derived from constraints files, simulation files or

vectorless analysis.

Total On-Chip Power:
Junction Temperature:
Thermal Margin:

Effective A

1485 W
276 °C
57.4°C (302 W)
18°CIW

Power supplied o off-chip devices: 0W

Confidence level:

Launch Power Constrai
invalid switching activity

High

nt Advisor to find and fix

On-Chip Power

?

0.182W  (18%)

D17W (12%)

Dynamic: 1.019W  (59%)
18% Clocks: 0021w
69% Signals:
Logic: 0.008W
M BRAM 0.685 W
W vmch:
[[{o 0.005W
31%
Device Static: 0466W (31%)

- O

el X

Figure 46: Power Report - With SAIF File Data

4. In the Tcl console, observe the read_saif results. This shows the percentage of design nets matched
with simulation SAIF. This is important for accurate power analysis.

5. Go to the Signals > Data view in the Power Report and scroll to the right. Note that all the Signal

Rate data has been set from simulation SAIF data you provided.
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The data is color coded to indicate activity rates read from the Simulation output file.

Power ? 08X
Q £ £ C  Q T Data Simulation Calculated
Settings Utilization Name Signal Rate (Mtr/s) % High Fanout  Slice Fanout ¢
Summary (1.455 W) ~ I 0.182 W (12% of total) 5 dut_fpoga -
Fower Supply 10.001 W (=1% oftotal) I dut/gen_dut|9].bram_top_instfaddr_a[1] 73000 63935 ks el
~ Utilization Details 10.001 W (=1% oftotal) T dutigen_dut{9].bram_top_instaddr_b[11] 72.000 36.040 a4 4 ¢
Hierarchical (1.019 W) 10.001 W (=1% oftotal) T dutigen_dutf1].bram_top_instbram_instimem_reg_2 0.1 2 n_0 74000  36.001 15 16 ¢
Clocks (0.021 W) 10.001 W (=1% oftotzl) T dubigen_dutia].bram_top_instbram_instimem_reg_0_0_i_3_n_0 73.000  36.011 16 16
~ Signals (0.1521) 10.001 W (=1% oftotal) T dutigen_dutf1.bram_top_instiaddr_b[16] 73000 63934 a7 3’
Data (0182 W) 10.001 W (=1% of total) I dut/gen_dut[9].bram_top_instaddr_b[3] 73.000  36.049 34 M4 o«
Clock Enable 10.001 W (=1% of total) I dut'gen_dut{9].bram_top_inst/bram_inst/mem_reg_0_0_i_4_n_0 73.000 36.019 16 16 ¢
Logiie;ﬁe_se_t:—l. ' 10.001W of total) I dut'gen_dut]8].bram_top_inst/bram_inst'mem_reg_2 0_i_1_n_0 72.000 36.000 16 16
BRAM 0535 W) 10.001 W (=1% of total) I dut/gen_dut[2].bram_top_instaddr_b[0] 73.000 63934 34 M4 o«
Clock Manager (0.117 W 10.001W of total) I dut/gen_dut{9].oram_top_instbram_instmem_reg_2_0_i_2_n_0 74000  36.001 16 16
10 (0.00 10.001 W (=1% oftotal) T dubigen_dut{9].bram_top_instaddr_p[o] 73000 63.934 34 M ¢
10.001W of total) I dut/gen_dut[2].bram_top_instaddr_bl5] 73.000 63936 34 M4 o«
10.001 W (=1% of total) I dut'gen_dut{9].bram_top_inst/bram_inst'/mem_reg_2 0_i_1_n_0 72000 36.000 16 16 ¢
10.001W (= of total) I dut'gen_dut{9].bram_top_instaddr_b[16] 73.000 63934 37 3/
10.001W(= of total) I dut'gen_dut]8].bram_top_inst/bram_inst'/mem_reg_0_0_i_4_n_0 73.000 36.019 16 16
10.001 W (=1% of total) I dut'gen_dut{2].bram_top_instaddr_b[1] T3.000 G63.936 34 34 c,
< > ¢ >
power_2 X  power_1 X

Figure 47: Signals > Data View with SAIF File Data

6. Note the change in total power (Total On-Chip Power in the Summary view) in the power_2
report compared to the power_1 report. The total power estimated in the report generated with
SAIF file data will be different than the total power estimated in the vectorless run (power_1 results).

Conclusion

In Lab 2, you have learned how to generate a SAIF file after running a timing level simulation using a
Vivado Simulator and Questa Advanced Simulator.

In Lab 3, you will learn about basic hardware power measurement technique using the KC705
Evaluation Board and correlating the hardware power numbers with the numbers generated by Vivado
Report Power.
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Lab 3: Measuring Hardware Power Using the
KC705 Evaluation Board

Introduction

In this lab, you will learn about basic hardware power measurement technique and correlating the
hardware power numbers with the numbers generated by Vivado® Report Power using KC705
evaluation board for 7 series devices. The lab will take you through the steps for setting up the
hardware measurement, programing a bit file using Vivado Hardware Manager and power
measurement through Texas Instruments (Tl) Fusion Design Software. It also includes Junction
Temperature reading from Vivado System Monitor.

Step 1: Generating a Bit File from the Implemented Design
(Non-Power Optimization)

1. In the Vivado Design Suite, open the 7 series Implemented design.
2. In the Flow Navigator, click Generate Bitstream.

The Bitstream Generation Completed dialog box appears after the bitstream has been generated.

Bitstream Generation Completed @

o Bitstream Generation successfully completed.

MHext
View Reports
@ Dpen Hardware Manager

Generate Memory Configuration File

Dont show this dialog again

Figure 48: Bitstream Generation Completed Dialog Box
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Evaluation Board

3. Open the Hardware Manager by selecting Open Hardware Manager in the Bitstream Generation
Completed dialog box and clicking OK.

Step 2: Setting Up the KC705 Evaluation Board

IMPORTANT: This project is created for the KC705 Rev 1.0 Evaluation Board. The pin constraints
are set based on this Evaluation Board. If you are using any other Revisions, update the XDC file
dut_fpga kc705.xdc with the correct pin constraints.

1. Connect the Digilent Cable (or Platform USB Cable) for Programming.
2. Connect the TI USB Interface Adapter to the PMBus port on the KC705 Evaluation Board.

3. Connect the Power Cable.

© @ ®

X14505

Figure 49: KC705 Hardware Setup

Power Analysis and Optimization www.xilinx.com Send Feedback 54
UG997 (v2020.1) July 8, 2020 I—\/_l


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&amp;docId=UG997&amp;Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&amp;releaseVersion=2018.2&amp;docPage=53
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2020.1&docPage=54

& XILINX

Evaluation Board

4.

www.ti.com/tool/fusion_digital_power_designer

Lab 3: Measuring Hardware Power Using the KC705

Install the Tl Fusion Digital Power Designer software on the PC from thislocation:

Step 3: Setting Up the Fusion Digital Power Designer
Software

1.

Power ON the KC705 Evaluation Board.

2. Open the Fusion Digital Power Designer.

The software detects the USB adapter and brings up the GUI.

File Device Tocls

Hep

UCD9248 @ Address 524 - Rail #1

Configure

[ Vout Config ‘[Ith,Wn,TEmp Config || Other Config || Phasz/Rail Cenfig | 610 Conig |

Sequence On and Off Timing )| [UCD9248 @ 52d - Rail #1
50 - , -
futo wite on rail o 3 il £3 — Voltage Setpoint, Margins, and Limits
device change LD Vou: Max: 1600 v
- 250 Rail #4 | Rail #1
= "
2 200 = ﬁm’ Rail £1 Over Fault: 11s0[F]v 15.0[F % OV eaponac
Stare RAM To Flash ] g 0 l : Over Wamn: 1100 [Z] v 0.0 5 %
1.00 1l 1l
Restore Flash to RAM ] 0.50 \ Margin High: 1,050 [+ v 5.0 %
0.00 Vout: 1.000 v
10 12 14 16 18 20 22 24 26 28 )
Time (msec) Margin Low: 0,950 E v 5.0 E % ?s’r‘;"r::;\ﬁx,l
Copy Rail/Design ] Undzr Warn: 0,900 E v -10.0 E o PG to Vout
Plot: Select Rail to Edit Review in Larger Window ()] | | Under Fault: 080V | 150 % UV Response
O = A
() Soft Stert Rail hame Dependendies (Di A Over CurrentLV: | 0870 v | -13.0[Z]% |OCLVResponse
() Soft Step 1 1
@
D UCD92%8 @ 52d 2 \IN_ON @ 6,000 V, VIN_CFF Poner GoodOn: | 0.900 v | -10.0F] %
Show rail sbels uCDs248 @ 52d 3 Ra #3 VIN_ON @ 6.000 U, VIN_CFF Power Good OF: | 0,350 S15.0 [ %
O S'wluw wurrenl devies UCDY29s @ b2d 4 2,500 10 Lesu DRI 30 LU VIN_ON @6.000 ¢, VIN_CFF|
only
ucps2 @53d 1 2500 2250 2125 0.0 50 10 1.0 VIN_ON @6.000 ¢, VIN_CFF On/Off Confag: 0x00 (Aways Cenverting)
ucpsz @ 53d 2 1500 1350 1275 00 5o 0.0 10 VIN_ON @6.000 v, VIN_CFf —Turn On Timing Turs OFf Timing
ucp92B @53d 3 1000 0500  0.850 0.0 50 7.0 1.0 VIN_ON &6.000 V, VIN_CFf| — Turn On Delay: 0.0[E]ms || Tum offDelay: 0.0 ns
LCNA2R @ 53d 4 1.200 1080 1070 oo 5N A0 1.0 VIN_ON & 5.000 U, VIN_CFF
UCD92%B @ 54d 1 Rai #1 2000 1800 1700 0.0 50 20 1.0 VIN_ON @6.000, VIN_CFF || | | | e Tme: 5.0 ms || Fal Tine: Lo ms
. Confi =
Tips & Hints PMBLs Log
./ Design
r ' TOFF_MAX_WARN_LIMIT [0x66,Rail §1]
I N Sets an Lpper limi: on how long the unit can attempt to powe- down the output without
-/ Moniter reaching 12.5% of the output voltage programmed at the time the converter is turned off,
A value cf 0x7FFF means that thers is no linit and that the unit waits indefinitely for the
1 status oulpul vallaye Wdecay.
L' Security | PMRus 1 0g | @

Fusion Digital Power Designer v1.8.325 [2013-05-07] | UCD9248 Firmware v5.3.0.11400 @ Address 52d | USB Adaptervl.0.14 [PEC; 400 kHz]

® Texas Insrruments | fusion digital power
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Step 4: Programming the Bitstream

1. Power up the KC705 Evaluation Board.

2. In the Vivado Hardware Manager, click Open Target in the green alert bar and select Open New
Target.

HARDWARE MANAGER - unconnected
0 Mo hardware target is open. Open target

£ Auto Connect
Hardware

Open Mew Target...

Mo content

Figure 51: Opening the New Hardware Target

3. In the Open New Hardware Target dialog box, click Next to go to the Hardware Server Settings.
4. Select the server to which the board is connected.
o If the board is connected to the local PC, select Local Server and click Next.

o If you are connecting to a remote server, see Connecting to a Hardware Target Using
hw_ server in the Vivado Design Suite User Guide: Programming and Debugging (UG908).

When the hardware is detected successfully, the part information will be displayed in the Open New
Hardware Target dialog box.
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5. Verify the part information, then click Next and Finish.

¢ Open New Hardware Target @

Select Hardware Target

Select a hardware target from the list of available targets, then setthe appropriate JTAG clock (TCK) frequency. If you do not see the ‘
expected devices, decrease the frequency or select a different target.

Hardware Targets
Type MName JTAG Clock Frequency
& xilink_tcf  Digilent/210203337377A 15000000 w

Add Xilinx Virtual Cable (XVC)

Hardware Devices (for unknown devices, specify the Instruction Register (IR) length)

Mame D Code IR Length
& xc7k3251_0 33651093 6

Hardware server: localhost 3121

Cancel

Figure 52: Hardware Target Detected

6. In the Hardware window, right-click the part and select Program Device.
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HARDVWWARE MANAGER - localhostixiling_tcfiDigilent210203337377A

€ There are no debug cores. Program device Refresh device

Hardware ? 00 X
Q = | = o
MName Status
~ B localhost (1) Connected
~ @ xiling_tcfiDigilenti2102033373..  Open
~ {8 xc7k325t_0 (1) Proarammad
£ XADC (System Monitor) Hardware Device Properties...

Program Device...
Verify Device...

* Refresh Device

Add Configuration Memary Device...

Boot from Configuration Memory Device

Program BBR Key...

Hardware Device Properties ? _ Clear BBR Key...

8 xcTR325_0 Program eFUSE Registers...
Name: XCTKA25t 0 E?:.Etjrttn Spreadsheet...
Part: XCTk325t
ID code: 33651093
IR length: 5]

Status: Programmed

Programming file:  ect_1/project_1.runsfimpl_1/dut_fpe
Probes file:

User chain count. 4

General Properties

Figure 53: Program Device

7. Select the bit file <project dir>/power tutoriall/power tutoriall.runs/impl 1/
dut fpga.bit and click Program.

8. After the program completes successfully, select XADC (System Monitor) in the Hardwarewindow,
then right-click and select Dashboard, and then select New Dashboard.

9. Click OK. The System Monitor window opens and plots Die Temperature (Junction Temperature)in
the Graph Window.
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l HARDAWARE MANAGER - locaihostiline_tciDiglent2 102033373774

© There are no debug cores. Program davice Rafreah osvice
Hardware dashboard_1
QiX |9 b XADC (xc7%325¢_0)
Stabus &
. gl -
Connected &
Open S |@rem
Pro 5 [mvee
@
System Monitor Core Properves :
@ xoc - -] S
Ha St3121liny_icbDigient2102033373774
4 18:2000
Tims (HH MM SS)
General

Figure 54: System Monitor — Junction Temperature Plot

Step 5: Measuring the Hardware Power Rails

1. In the Fusion Digital Power Designer, select a rail in the Configure view and click Monitor.

File Dewce Tooks Hely D246 § Address 52 -Rad 31

Configure vout Config [ Tout, vin, Temp Contg | Other Config | Phase Rai Config | GPIO Config

Sequence On and Off Timing v [UCD924R @ 524 - Rail #1

Austo write on rad o pon Rail #3 — Voltage Setpomt, Margins, and Limt s —————————————————————
device change 300+ 1600 (5] v
5 i 1150 ] v 15005 % OV Resgorae [+
Rore RAM To Flash . = = v p h o 1,300 (=1 v 10.0/5] %
Prestore Flash to RAM . / \ Loy sofi%
24 26 E =

14 16 18

Syndvone

Time (msec) marges Aemts|
2il/Desy PG % Vout
Select Rall to Edit Review i Larger Window () R
Device Rai# RaiMame | Vout (PGOn PGOff OnDelay Rse OffDelay Fal  Deperdences Drect.. | 087 5y 105 % | OCLYResporse

2,900
— Turn On Timing - (~ Trn OF Timing -
T On Oelay ms ff elay: 0.0[5] ms
Rise Tme: 5,05 ms || Fol Teme: Lofims

Security &) | mstop ]

Fusson Drgital Power Designer v1.8.325 [2013-05-07) | UCDI48 Furmnware v28.0.11400 © Address 52d | USB Adapter v1.0.14 [PEC; 400 ki) B Texas ivsmmaients | husion digital power

Figure 55: Select a Rail to Monitor

2. Configure the parameters to be monitored. An Output Power graph will be plotted in the Monitor
window.
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Figure 56: Monitor a Rail - Power and Junction Temperature

that rail information is displayed in terms of Regulator address.

VCCAUX 1.8V

130 vccavs 3.3V
4 vaD) 2.5V
F1 vccavs 2.5v
2 vcels 1.5V
'3 MGT_AvCC 1.0V
4 MGT_AVTT 1.2v
1 vccaux_io 1.8V
VCCBRAM 1.0V
|3 MGT_VCCAUX 1.8V
4| n/A N/A

0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0xEBDC
0XEBDC
/A

Figure 57: KC705 Rail Address Mapping

Digital Power Designer.

Power Analysis and Optimization
UG997 (v2020.1) July 8, 2020

www.Xxilinx.com

0x8000
0x8000
0%8000
0%8000
0x8000
0x8000
0%8000
0x8000
0x8000
0%8000
0x8000
N/A

| Send Feedback l

3. Repeat the steps above to monitor the power information for each rail supplied to the device. Note

4. Note the Junction Temperature value either from the Vivado Hardware Manager or from the Fusion
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Step 6: Estimating Vectorless Power with Junction
Temperature

For further Power Analysis, you can use the measured Junction Temperature and other thermal settings
to feed into Vivado Report Power for better accuracy.

1.

In the Vivado Design Suite, open the tutorial project and click Open Implemented Designto
display the implemented design.

In the Tcl Console, run the following command to reset any user defined or SAIF file defined
settings.

reset switching activity -all
In the main menu bar, select Reports > Report Power.

In the Report Power dialog box Environment tab, enter the Junction Temperature valuesupplied
by the hardware power measurement.

Set the Process to maximum.
In the Switching tab, make sure the Simulation activity file (saif) is blank.

Click OK.
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¢ Report Power

Estimate power consumption based on the netlist design and parn xcku040-ffva1156-2-e.

el
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Device Settings
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Figure 58: Report Power Settings — Updating Junction Temperature
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8. In the Power Report, observe that the power numbers increase slightly as compared to the
vectorless power analysis using a default Junction Temperature value. Note that the Junction
Temperature is now color coded as being user defined in the Power Report.

Power ? -0 a X
Q = = ” Summary
Settings )
g Power analysis fram Implemented netlist. Activity On-Chip Power
Summary (1.578 W) derived from constraints files, simulation files or
Pawer Supply vectorless analysis. Dynamic: 1.017W  (65%)
~ Utilization Details
Total On-Chip Power: 1.576 W Clocks: 0.024 W
Hierarchical (1.017 Junction T ture: 30.0°C . 23% ' ' !
Clocks (0.024 W) unction em.pem ure ' Signals: 0.232W
v Signals 0. Thermal Margin: 51.0 °C (26.7 W) Logic: 0.016 W
Data(0232y ~ Enectve 3JA 187w W ERAM: 0624 W
Clock Enable ( Power supplied to off-chip devices: 0W B MNCH: 0417 W
SetReset (0 V Confidence level: Medium o 0004W (0%
B 35%
Logic (L V) Launch Power Constraint Advisor to find and fix
BRAM (0.5 invalid switching activity Device Static. ~ 0.550W  (35%)
Clock Manager (0.
IC (0.004 W)
| ¢ I o _______
power_1

Figure 59: Power Report - Vectorless Analysis with Junction Temperature Supplied

9. Similarly, you can overwrite the Junction Temperature setting and do a SAIF based power analysis.

Note the power numbers measured and estimated on non-power Optimized design.

Conclusion

In this lab, you have completed a Vivado Report Power analysis on post-synthesis and post-
implementation netlist designs without Power Optimization. You also experimented with hardware
power measurement using the KC705 Evaluation Board and with reading Junction Temperature for
software analysis.

In lab 4, you will learn to experiment with hardware power measurement using the KCU105
Evaluation Board and with reading Junction Temperature for software analysis.
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Lab 4: Measuring Hardware Power Using the KCU105
Evaluation Board

Introduction

In this lab, you will learn about the basic hardware power measurement technique and correlating the
hardware power numbers with the numbers generated by Vivado® Report Power using the KCU105
evaluation board for UltraScale™ devices. The lab will take you through the steps for setting up the
hardware measurement, programing a bit file using the Vivado Hardware Manager and power
measurement through the Maxim Digital Power Tool. It also includes the Junction Temperature reading
from the Vivado System Monitor.

Step 1: Generating a Bit File from the Implemented Design

1. In the Vivado Design Suite, open the UltraScale Implemented design.
2. In the Flow Navigator, click Generate Bitstream.
3. When prompted to Save project before generating bitstream, click Don’t Save.

The Bitstream Generation Completed dialog box appears after the bitstream has been generated.

Bitstrearn Generation Completed @

[0] Bitstream Generation successfully completed.

Mext

View Reports

@ Dpen Hardware Manager

Generate Memory Configuration File

Don't show this dialog again

CK | | Cancel

Figure 60: BitStream Generation Dialog Box
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4. Select Open Hardware Manager in the Bitstream Generation Dialog box and click OK toopen
the Hardware Manager.

Step 2: Setting up the KCU105 Evaluation Board

IMPORTANT: This project is created for the KCU105 Rev B Evaluation Board. The pin constraints
are set based on this Evaluation Board. If you are using any other Revisions, update the XDC file
dut_ fpga kcul05.xdc with the correct pin constraints.

1. Connect the Digilent Cable (or Platform USB Cable) for Programming.

2. Connect the MAXPOWERTOOLO002# Interface Adapter to the PMBus port on the KCU105 Evaluation
Board.

3. Connect the Power Cable.

X18320-032418

Figure 61: KCU105 Hardware Setup
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4. Install the Maxim Digital Power Designer software on the PC from this location.

https://www.maximintegrated.com/en/products/power/switching-regulators/MAXPOWERTOOLO002.html

Step 3: Configuring the Maxim Digital Power Tool Software

1. Power ON the KCU105 Evaluation board.

2. Open the Maxim Digital Power Tool. The software detects the Interface adapter and brings up the
GULI.

Dashboard

MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301

Product ~ MAX15301 ~ MAX15303AA00 MAX15303AA00 MAX15303AA00  MAX1S301  MAXI5303AA00 MAX15303AA00 MAX15303AA00 MAX15303AA00  MAX15301 —gmmg: =
—— O0x18:MAX15303 ——
6
Use Hardware Enable 5
4
e
Input Voltage (V) 11422 y ; 573
=
2
Output Current (A) 1
0
1360
Internal Temperature (*C)
bigasl id - : - | - emma—

Power Good o (] (+] (] (+] o (] (+] (4] o a0 ’
25

Clear Faults Clear Clear Clear Clear Clear Clear Clear Clear Clear. Clear e
s ~

Vout (V)
—

0950 2 1.800 5 0950 -2 1.800 5 1.800 5 1200 & 1.000 5 1.200 £ 1.800 5 3300 2 10
On Delay Time (ms) | 498 21| 1180 & | 78221 | 1975 & | 284 2| 2488 21| 1009 & | 15222 1975 1| 1002 :: /
La S - -~ -~ o~ -~ - o 10 Ed
202 28 232 20 1772 232 28 235 =4 188 2 183 2 188 2 234 28 2134 Z—
Off Delay Time (ms) | 2497 & | 187 & 1988 5 | 796 5] | s | su | 1988 3} | 1478 3 | 103F]| 3009 F] Start Up

202 28 232 2 177 =4 232 28 235 =i 188 =4 183 = 188 = 234 28 213 Bl oo For Deviees) (Save

Figure 62: Maxim Digital Power Tool

Step 4: Programming the Bitstream

1. In the Vivado Hardware Manager, click Open Target in the green alert bar and select OpenNew
Target.

2. In the Open New Hardware Target dialog box, click Next to go to the Hardware Server Settings.
3. Select the server to which the board is connected.
o If the board is connected to the local PC, select Local Server and click Next.

o If you are connecting to a remote server, see Connecting to a Hardware Target Using
hw_server in the Vivado Design Suite User Guide: Programming and Debugging (UG908).
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When the hardware is detected successfully, the part information will be displayed in the Open
New Hardware Target dialog box.

4. Verify the part information, then click Next and Finish.

Ex5

Select Hardware Target
Select a hardware target from the list of available targets, then set the appropriate JTAG clock (TCK) frequency. If you do not see the ‘
expected devices, decrease the frequency or select a different target.

¢ Open New Hardware Target

Hardware Targets
Type Mame JTAG Clock Frequency
@ xlinx_tcf  Digilent’210251845034 15000000 ~

Add Xilinx Virtual Cable (XVC)

Hardware Devices (for unknown devices, specify the Instruction Register (IR) length)

Mame ID Code IR Length
€ xcku040_0 13822002 6

Hardware server: localhost3121

Cancel

Figure 63: Detecting the Hardware Target

5. In the Hardware Devices window, right-click the part and select Program Device.
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HARDWARE MANAGER - localhostixiling_tcfiDigilent210251845034

@ There are no debug cores. Program device Refresh device

Hardware
Q T =
e, -

MName

~ F localhost (1)

~ {8 xcku040_0 (1)

& SysMon (System Maonif

{ |
Hardware Device Properties
{8k ¥cku040_0

Mame: xcku040_0

Part: xcku040

ID code: 13822003

IR length: G

Status: Mot programmed

Programming file:

Probes file:

User chain count. 4

C

?

~ e ilink_tciiDigilent’2102512450...

— OO X
&

Status
Connected
Open

Klnt Rrnarame

Hardware Device Properties...

Program Device. .
Werify Device...

Refresh Device

Add Configuration Memaory Device. .

Boot from Configuration Memory Device

Program BER Key. .
Clear BER Key...

Program eFUSE Registers...

Export to Spreadsheet...

General Properties

Tcl Console ®  Messages Serial 'O Links Serial I'0 Scans

Figure 64: Program Device setup

6. Select the bit file from the implementation runs directory of the project which is created in Lab 2 for
UltraScale design <project_dir>/power_tutorial2/power_tutorial2.runs/impl_1/ dut_fpga.bit and click

Program.

7. After the program completes successfully, select XADC (System Monitor) in the Hardwarewindow,
then right-click and select Dashboard, and then select New Dashboard.

Power Analysis and Optimization
UG997 (v2020.1) July 8, 2020

www.xilinx.com

l Send Feedback l 68


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&amp;docId=UG997&amp;Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&amp;releaseVersion=2018.2&amp;docPage=64
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2020.1&docPage=68

& XILINX

Evaluation Board

Lab 4: Measuring Hardware Power Using the KCU105

HARDWARE MANAGER - localhostiilin_tcfiDigilent’210251845034

ﬂ There are no debug cores. Program device Refresh device

Hardware
Q = =

Mame
~ B localhost(1)

~ 8 xcku040_0 (1)
HE SysMon (System M

~ B wiling_tcfiDigilent!2102518450... Open

? 00 X
e

Status
Connected

Mot programm

dashboard_2

SysMon (xcku040_0)
+ -
B Temp 31.2°C

shboard Options

System Monitar Core Properties. ..

JTAG Scan Rate

Dashboard

Export to Spreadsheet...

T

System Monitor Core Properties

& SysMon

Mame: SysMan

? 00X
- o

Handle: localhost3121&linx_tcfiDigilenti210251845034/

b
» = mewDashboard...

dashboard_2

Figure 65: Creating a New Dashboard

8. Click OK. The System Monitor window opens and plots Die Temperature (Junction Temperature)in

the Graph Window.
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Temperature (°C)

10:10:45 10:11:00 1011115

10:11:30
Time (HH:MM:55)

Figure 66: System Monitor- Junction Temperature Plot for UltraScale Device
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Step 5: Measuring the Hardware Power Rails

1. In the Maxim Digital Power GUI, select a rail to monitor the power information.

@ Maxim PowerTool™ (1.09.05) o|[@ R
Dashboard 0x0A 0x0B | ox0F Ox11 | ox12 | 0x14 0x15 [ 0x16 0x18 0x1B
| MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301
Configuration | Monitor | Faults Set [ PMBus Command | Permissions | Tools |
Vout Margin High (V) 0.99: Input Voltage (V) 11.875
Switching Frequency Set Point (kHz) 400 =] Switching Frequency (kHz) 400
Power Good On (V) 0852 =] External Temperature (*C) 42
| Strtup/Shtdown Tines g
On DeloyTime (ms sss || QU Gaibration
On Rise Time (ms) | 202 5 EXT_TEMP_CAL-m 1.0039 %
Off Delay Time (ms) | 2497 (2] EXT_TEMP_CAL-b 000
Off Fall Time (ms) | 202 &
IOUT_CAL GAIN (mQ) 0550
IOUT_CAL OFFSET (A) 1199
=) Margin High, Ignore Faults ) Margin High, Act on Faults
O Noml  Advanced Configuation
(©) Margin Low, Ignore Faults ©) Margin Low, Act on Faults -
@ Soft Stop () Tristate Stop Advanced Configuration|
[[Load on File to Device |
[ StoreUserAll ][ Restore User Al |[ Restore Maxim All_|[_Restore Default All |

Figure 67: Selecting a Rail to Monitor

2. In Configuration tab, you can observe the basic settings and device status.

3. Click Monitor tab to observe the voltage and current plots.
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@) Maxim PowerTool™ (1.09.05) o[- [
Dashboard DxDA I 0x0B Dx0F 0x11 0x12 0x14 0x15 0x16 0x18 Ox1B
MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301
Ci on | Monitor | Faults Set | PMBus Command | Permissions | Tools
G Vout (V): Min: 0.950 Max: 0.950 Avg: 0.950 VIN (V): Min: 11.875 Max: 11.875 Avg: 11.875
On/Cff Config 0x16 — vour -~ VOUT FAULT LINIT [—wn - VIN FAULT LT
20
16
Vout Command (V) 0950 S I A A O
Vout Max (V) 1045 8 12
10
Tout Cal Gain 055 € | B
5 e e Y Y S g=
= 8
0.5 P T TEEEEE
Input Voltage (V) 11875
2
Output Voltage (V) 0950 00 o
300 310 320 930 340 330 300 310 320 330
Qutput Current (&) 320 Sample sample
Sl M g () <l lout {A): Min: 3.203 Max: 3.344 Avg: 3.262 Internal Tem perature (C): Min: 48.563 Max: 48.625 Avg: 48.608
Internal Temperature (DCJ 48 |— our === 1OUT FAULT LIMIT —— TEMPERATURE ----- TEMP FAULT LINMIT
External Temperature (°C) 43 L e e e A S ——
40 e <
@
Duty Cycle (%) 753 2 o
= 30 E
S 5 80
Status = 2
3 £ w
Fault Warning = =
=
Vout Under Voltage (] [#] 0 E 0
E
Tout Over Current (@] () £
- 0 0
Vin Over Valtage o o s00 s10 820 930 340 330 800 310 920 930
Vin Under Voltage (] (w] Sample Sample
Vout Over Voltage [#] o Stop Plotting |

Figure 68: Monitoring a Rail - Voltage and Current

device.

Repeat the steps mentioned above to monitor the power information for each rail supplied to the

Note that the rail information is displayed in terms of Regulator address.

RAIL

VOLTAGE

PMBUS ADDR

VCCINT

0.95v O0x0A

VCCAUX

1.8V 0x0B

VCCBRAM

0.95v OxOF

VCC1v8

1.8V O0x11

VADJ_1V8

1.8V Ox12

VCC1Vv2

1.2V O0x14

MGTAVCC

A% 0x15

MGTAVTT

1.2V 0x16

MGTAVCCAUX

1.8V 0x18

UTIL_3V3

3.3V Ox1B
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Step 6: Estimating the Vectorless Power with Junction
Temperature

For further Power Analysis, you can use the measured Junction Temperature and other thermal settings
to feed into Vivado Report Power for better accuracy.

6. In the Vivado Design Suite, open the tutorial project and click Open Implemented Designto
display the implemented design.

7. In the Tcl Console, run the following command to reset any user defined or SAIF file defined
settings.

reset switching activity -all
8. In the main menu bar, select Reports > Report Power.

9. In the Environment tab of Report Power dialog box, enter the Junction Temperature value
supplied by the hardware power measurement.

10. Set the Process to maximum.
11. In the Switching tab, make sure that the Simulation activity file (saif) is blank.

12. Click OK.
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Lab 4: Measuring Hardware Power Using the KCU105

¢ Report Power

Estimate power consumption based on the netlist design and part xcku040-ffva1156-2-e.

5
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Figure 69: Reporting Power Settings — Updating Junction Temperature
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Evaluation Board

Lab 4: Measuring Hardware Power Using the KCU105

13. In the Power Report, observe that the power numbers increase slightly as compared to the

vectorless power analysis using a default Junction Temperature value.

Note that the Junction Temperature is now color coded as being user defined in the Power

Report.
Power ? —0Oa
Q = £ C 7  summay
Settings - ) -~
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary (3.063 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.850W  (60%)
~ Utilization Details
Total On-Chip Power: 3.063W i . .
. . Clocks: 0.114W
Hierarchical (1.85 Junction T " 40.0°C 60% 2904
unction Temperature: : : .
Clocks (0.114 W) P e Signals:  0.385W
- . \
~ Signals (0 . Thermal Margin: 60.0 °C (39.4 W) Logic: 0.089W
Data (0. Effective SJA: 14w WERAM: 1132w
Clock Enable Power supplied to off-chip devices: 0W M ch: 0125 W
Set/Reset (07 Confidence level: Medium 0
40% 10 0.004 W
Logic (0.088 W) Launch Power Constraint Advisor to find and fix
BRAM (1.132 W) invalid switching acivit Device Static. ~ 1.213W  (40%)

Clock Mananer (01 ~
b

impl_1 (saved) X

power_1 x

14. Similarly, you can overwrite the Junction Temperature setting and do a SAIF based power analysis.

Figure 70: Power Report — Vector Analysis with Junction Temperature Supplied

Conclusion

In this lab, you have learned to experiment with hardware power measurement using the KCU105
Evaluation Board.

In lab 5, you will learn about using the Power Optimization features in the Vivado IDE.
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Lab 5: Performing Power Optimization

Introduction

In this lab, you will learn about using the Power Optimization features in Vivado® for 7 series devices.
The lab will take you through the steps for invoking Power Optimization after synthesizing the design. It
will also guide you on how to use the power optimization report, make decisions and selectively turn off
power optimization on signals, blocks, and hierarchies.

TIP: When you run Implementation on your design, the Vivado tools may perform BRAM power
optimizations by default during opt design. These optimizations will not affect performance,
and will have little impact on area and runtime. In the previous Lab, the default BRAM power
optimization was disabled (Step-9 of Lab1) by setting a NoBramPowerOpt directive to

opt design.

Step 1: Setting Up Options to Run Power Optimization

1. In the Flow Navigator, right click Implementation and select Implementation Settings.
2. In the Project Settings dialog box, select Implementation tab to make the following settings:
e Inthe Opt Design settings, set the -directive option to Default.

BRAM optimization runs in the Default setting for Opt Design during Implementation. BRAM
optimization was disabled in the previous lab. It is now re-enabled when the design runs Power
Optimization.

¢ In the Power Opt Design settings, check the is_enabled box.

This ensures Power Optimization runs after opt design. Enabling the Power Opt Design
option prior to place designresults in a complete power optimization to be performed. This
option yields the best possible power saving from the Vivado tools.

Power Analysis and Optimization www.xilinx.com Send Feedback 76
UG997 (v2020.1) July 8, 2020 I—\/_l


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&amp;docId=UG997&amp;Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&amp;releaseVersion=2018.2&amp;docPage=76
https://www.xilinx.com/about/feedback/document-feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2020.1&docPage=76

& XILINX

¢ Settings

Project Settings
General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

» P

Tool Settings
Project
IP Defaults
Source File
Display
WebTalk
Help
» Text Editor
3rd Party Simulato
» Colors
Selection Rules

Shortcuts
Sfrategies
» Window Behavior .
4 »
|/"_3;'\|
Wi/
3. Click OK.
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Implementation
Specify various settings associated to Implementation ‘

Constraints

Default constraint set: | &= constrs_1 (active) o

Options

WL LSy UL WSy
is_enabled '
tcl pre E|
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-verbose
-directive® MoBramPowerOpt 4
Mare Options
~ Power Opt Design (power_opt_design)
is_enabled v |

tcl.pre

HiH

tcl.post

Mare Options
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Optionally run this step as part of the flow. This step optimizes design to maximize power saving.

QK | | Cancel | | Apply | |Bestore...

Figure 71: Implementation Settings — Enabling Power Optimization
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4. In the Create New Run dialog box, click Yes to “Properties for the completed run ‘impl_1" have been
modified. Do you want to preserve the state of 'impl_1" and apply these changes to a new run?”.

Create New Run @

Froperties for the completed run ‘impl_1" have been modified.
Do you want to preserve the state of impl_1" and apply these changes to a new run?

|:| Dont show this dialog again

Yes Mo Cancel

Figure 72: Create New Run Dialog Box

5. In the Create Run dialog box, set the Run Name to impl 2.
6. Click OK.

7. In the Flow Navigator, select Run Implementation. Click Don't Save when the Save Projectwindow
pops up to save both Synthesis and Implementation constraints.

[ =

¢ Save Project @

e Save project befare l[aunching implementation?

Data to Save
+'| Bynthesized Design - constrs_1 - dut_fpga kc705.xdc

+ | Implemented Design - constrs_1 - dut_fpoa_kc705 xdc

Dont Save Cancel

Figure 73: Click “Don’t Save” Here

You are running Implementation with Power Optimization turned on.
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8. In the Implementation Completed dialog box, select Open Implemented Design and clickOK. Click
Don't Save when the Save Project window pops up to save both Synthesis and Implementation
constraints.

Step 2: Running report power opt to Examine
User/Design Specific Power Optimizations

1. In the Flow Navigator, select Implemented Design.

2. In the main menu bar, select Reports > Report Power Optimization.

Reports Window Layout View

Report |P Status I

Compare Block Designs...

=

10 > |

Timing A
[F] Report Methodology...

Report DRC...

Report Design Analysis...
Report QoR Suggestions...
Report Utilization...
Report Clock Utilization...

& Report Power... i
Report Power Optimization...
Report High Fanout Nets...

Open Interactive Report...

Figure 74: Generating a Power Optimization Report
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3. The Report Power Optimization dialog box appears, as shown in the following figure.

[ o]

¢ Report Power Optimization @

Report power optimization.

Results name: power_opt_1

Export to file:
Qutput file format;

| Openin anew tab
f_ﬂ"-

Figure 75: Report Power Optimization Dialog Box

4. Enter power opt 1 for the Results name.

5. Ensure that the Open in a new tab option is checked.

6. Click OK. Alternatively, in the Tcl Console execute this Tcl command:
report power opt -name power opt 1

7. Observe the report power_opt_1 is generated in the Power Opt tab of the results windowsarea.
When the report opens, the Summary view is displayed in the report.

8. In the Summary view, note that 50% of the BRAMs are clock gated by the tool duringPower
Optimization.

Create Mew Eun @

FProperies for the completed run ‘impl_1" have been modified.
Do you want to preserve the state of impl_1" and apply these changes to a new run?

[

D Doaont show this dialog again

Zancel

1=
o

w

=
[=]

Figure 76: Power Optimization Report — Tool Gated BRAMs
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9. In the Power Optimization Report, select Hierarchical Information > BRAMs > Tool Gated
BRAMs and observe the BRAM cells and its CE ports which are gated by the tool during the power
optimization.

Step 3: Running report power to Examine Power Savings

1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, make the following settings:
o Specify the Results name as power 1
o In the Environment tab, make sure the Process is set to maximum.
3. Click OK. Alternatively, in the Tcl Console execute this Tcl command:
report_power —name power_l

4. In the Summary view of the Power Report, observe an approximately 100-200mW power savings
compared to the non-optimized power run in the previous lab.

You can generate a bitstream to program the hardware and measure its power, to observe the
power saving in hardware. See Lab 3: Measuring Hardware Power Using the KC705 Evaluation for
hardware power measurement instructions.

Power ? 08 X
Q T 2 C 7 summay
Settings - )
g Power analysis from Implemented netlist. Activity On-Chip Power
Bummary (1.43 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.017W  (69%)
~ Utilization Details
Total On-Chip Power: 148'W . \
Hierarchical (1.017 ] 2394 Clocks: 0.024W
Clocks (0024 W) Junction Temperature: 276 °C 59% Signals:  0.232W
~ Signals ( Thermal Margin: 57.4°C(30.2W) Logic: 0.016W
Data (0.232 W Effective 3JA: 1.8 °C/IW B ERAM: 0.624W
Clock Enable | Power supplied to off-chip devices: 0W W 0417 W
SetiReset (0 Confidence level: Medium 1o 0.004W
Logic Launch Power Constraint Advisor to find and fix L
BRAN (0524 W) invalid switching activity Device Static. ~ 0.463W  (21%)
Clock Manager (0.,
S —— L
power_1

Figure 77: Power Savings with Power Optimization
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Step 4: Turning Off Optimizations on Specific Signals and
Rerunning the Implementation

In this step you will learn how to turn off the power optimization on specific BRAMs.

IMPORTANT: Power optimization works to minimize the impact on timing while maximizing

power savings. However, in certain cases, if timing degrades after power optimization, you can
(dentify and apply power optimizations only on non-timing critical clock domains or modules

using the set _power opt XDC command.

See the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more
information on the set _power opt command.

Assume that this BRAM is in the critical path:

dut/gen dut[0].bram top inst/bram inst/mem reg 0 0
This step makes sure the tool does not gate this BRAM.

1. In the Tcl Console, type this command:
set_power_opt -exclude _cells [get_cells dut/gen dut[0].bram top_inst/bram inst/mem reg 0_0]
This will prevent the tool from gating this BRAM.

2. From the Flow Navigator choose Run Implementation, which in turn reruns
power opt design.
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3. Click Save in the Save Project dialog box to save the Synthesized Design and Implemented Design
constraints before launching implementation.

-

ﬁ"" Save Project @

[9:, Save project before launching implementation?

Data to Save

| Synthesized Design - synth_1 - constrs_1 - dut_fpga_kc?05. xdc

| Implemented Design - impl_1 - constrs_1 - dut_fpga_kc705, xdc

| Implemented Design -impl_2 - constrs_1 - dut_fpga_kc705. xdc

[ Save || Don't Save || Cancel

Figure 78: Save Design Constraints Before Rerunning Implementation

Also, select Implemented Design - impl_2 in the Save Constraints Conflict dialog box to save the
changes in constraints from the set power opt command.

ﬁ"‘_ Save Constraints Conflict @

! There are unsaved changes to constraints set 'constrs_1' in multiple editors, Please
choase which changes to save.

Changes to Save
Synthesized Design - synth_1

Implemented Design - impl_1

@ Implemented Design -impl 2

QK ] | Cancel

Figure 79: Saving Design Constraints for impl_2

4. In the Implementation Completed dialog box, select Open Implemented Design and click OK.
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Step 5: Running report power opt to Examine Tool
Optimizations Again
1. In the main menu bar, select Reports > Report Power Optimization.

2. In the Report Power Optimization dialog box, type in the Results name aspower opt 2.
Alternatively, execute this Tcl command in the Tcl Console:

report power opt -name power opt 2

3. In the generated report power_opt_2 in the Power Opt window, display Tool Gated BRAMs.

Power Opt ? —0Oa X
Q| =|&|¢€ Q. Tool Gated BRAMs
General Information Cell Name CE Port CE NetName
Summary mem_reg_0_0 (RAMB36E1) ENARDEN  dut/gen_dut0].bram_top_inst/bram_instmem_reg_0_0_ENARDEN_cooolgate_en_sig_2 =
Recommendations mem_reg_0_0 (RAMB36E1) ENBWREN  dut/gen_dut{0].bram_top_inst/bram_instmem_reg_0_0_ENBWREN_cooolgate_en_sig_11
~ Hierarchical Information mem_reg_0_1 (RAMB36E1) ENARDEN  dut/gen_dut[0].bram_top_inst/bram_instmem_reg_0_1_ENARDEN_cooolgate_en_sig_3
 BRAMNS mem_reg_0_1 (RAMB36E1) ENBWREN  dut/gen_dut[0].bram_top_inst/bram_instmem_reg_0_1_ENBWREN_cooolgate_en_sig_12
User Gated BRAMs mem_reg_0_2 (RAMB36E1) ENARDEN  dutigen_dut[0].bram_top_instbram_instmem_reg_0_2_ENARDEN_cooolgate_en_sig_4
ool Gated BRAMSI mem_reg_0_2 (RAMB36E1) ENBWREN  dut/gen_dut{0] bram_top_inst/bram_instmem_reg_0_2_ENBWREN_cooolgate_en_sig_13
BRAMWRITE_MODEO oy reg 0_3 (RAMB36E1) ENARDEN  dut/gen_dutj0].bram_top_instibram_instmem_reg_0_3_ENARDEN_cooolgate_en_sig_5
SRLs mem_reg_0_3 (RAMB36E1) ENBWREN  dut/gen_dut[0].bram_top_inst/bram_instmem_reg_0_3_ENBWREN_cooolgate_en_sig_14
ViSlicE Reglstbts mem_reg_0_4 (RAMB36E1) ENARDEN  dut/gen_dut[0].bram_top_inst/bram_instmem_reg_0_4_ENARDEN_cooolgate_en_sig_6
U Gated Slice Regi
Serealedsiice Re0IS  em_reg_0_4 (RAMB36ET)  ENBWREN  dutigen_dufolbram_top_instbram_instmem_reg_0_4_ENBWREN_cooolgate_en_sig_15
Tool Gated Slice Regist
Pl ' L mem_reg_0_5 (RAMB36E1) ENARDEN dut/gen_dut{0].bram_top_inst/bram_instmem_reg_0_5_ENARDEN_cooolgate_en_sig_7
s
= mem_reg_0_5 (RAMB36E1) ENBWREN  dut/gen_dut[0].bram_top_instbram_instmem_reg_0_5_ENBWREN_cooolgate_en_sig_16
mem_reg_0_6 (RAMB36E1) ENARDEN dut/gen_dut{0].bram_top_inst/bram_inst'mem_reg_0_6_ENARDEN_cooolgate_en_sig_8
< > _mem req 0 6 (RAMB36E1) ENBWREN __ dut/gen dut/0].bram top_instbram instmem req 0 6 ENBWREN cooolqate en siq 17 v
power_opt_1
Figure 80: Displaying Tool Gated BRAMs
4. Note that this BRAM is no longer in the list of Tool Gated BRAMs:
dut/gen dut[0].bram top inst/bram inst/mem reg 0 O
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Step 6: Saving Power using UltraScale BRAM in Cascaded
Mode

UltraScale architecture-based devices provide the capability to cascade the data out from one BRAM to
the next BRAM serially. This will enable the devices to create a deeper block RAM in a bottom-up
fashion. When used in cascaded mode, the power consumption is considerably low compared to the
BRAM used in non-cascaded mode.

1.

Run the steps mentioned in Step 1: Creating a New Project shown in Lab 1: Running Power
Analysis in the Vivado Tools.
a. Inthe Add Source Files dialog box, navigate to the
<Extract Dir>/UltraScale/src for UltraScale devices.
b. In the Add Constraints (optional) dialog box, click Add Files and select
dut fpga kcul05.xdcin the file browser. In the directory structure, you will find the
dut fpga kcul05.xdc file below the /src folder.
c. Select the Kintex-UltraScale KCU105 Evaluation Platform (xcku040-ffva156-2-e FPGA),
click Next.
Review the New Project Summary page. Verify that the data appears as expected and click
Finish.
In the Vivado Options dialog box (Tools > Options > General), enter the tutorial project
directory in the Specify project directory box, so that all reports are saved in thetutorial
project directory. Then click OK.
Click Run Synthesis in the Flow Navigator.

The Synthesis Completed dialog box appears after synthesis has completed on the design.

Select Run Implementation in the Synthesis Completed dialog box and click OK.

After the Implementation completes, click Open Implemented Design.

You can see the automatically generated power report impl 1inthe power tab, which shows
as a saved report. This is an autogenerated vectorless power report.

Note the total power (Total On-Chip Power) in the power report Summary page.
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Figure 81: Power Report Summary

9. Select Hierarchical view in the Utilization Details option on the left panel and observe the
Cascaded and Non-cascaded BRAM power.

Power 7?7 -0aXx
Q = & C Q. = Hierarchical
Settings Utilization MName Clocks (W) Signals (W) Data(W) Logic(W) BRAM(W) ClockManager (\
Summary (2.352 W) ~ I 1.853 W (79% of total) 3 dut_fpga
Power Supply v I 1.719'W of total) [@ dut (dut) 0.105 0.393 0.393 0.089 1132 =0.0(
~ Utilization Details > I 1152 W (4 total) [3] Noncascade_bram (Noncascade . 0.052 0173 0173 0.051 0.875 =0.0(
> [ 0.567 W (249 [3] Cascaded bram (Cascaded bram) 0.052 0.22 022 0.038 0.257 =0.0(
Cloeks (0.17W) M 0.131 W (6% of total) Leaf Cells (12)
~ Signals ( <1% of total) @ in_difi_bufg (IBUFDS) =0.001 =0.001  =0.001 <0.001 <0.001 <0.0(
Data (0.393 W)
Clock Enable (0}
SetReset (0 W)
Logic (0.089 W)
BRAM (1.12 )
Clock Manager (0.125 W)
1/0 (0.004 W)
¢ — T 4
impl_2 (saved)

Figure 82: Cascaded and Non Cascaded BRAM Power view

10. You can see 50% to 60% saving in Cascaded BRAM compared to Non Cascaded BRAM.

11. Use the same steps as specified in Step 1, Step 2, and Step 3 to perform SAIF based power
analysis using Vivado Simulator.
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Conclusion

In this tutorial, we have accomplished the following:

Used the Report Power dialog box to verify and set device, thermal, and environmental
conditions that contribute to power estimation.

Synthesized the design and estimated the power after synthesis.
Set switching activities on an 1/O port and reran Report Power.

Ran functional simulation using the Vivado simulator and generated a SAIF file that is input to
Report Power for a more accurate power analysis.

Implemented the design, ran post-implementation timing simulation using the Vivado simulator,
and generated a SAIF file that is input to report power for a more accurate power analysis.

Ran Questa Advanced Simulator post-implementation timing simulation and generated aSAIF
file that is input to report power for a more accurate power analysis.

Performed power measurement on the design implemented in a KC705 and KCU105 Evaluation
Boards. Compared the hardware power numbers with the numbers generated by Vivado Report
Power.

Learned how to achieve power optimization as part of an implementation run.

Examined the power optimization report and selectively turned off power optimizations on a cell
in the design.

Examined the power saving of UltraScale BRAMs in cascaded mode when compared to BRAMs
in Non-cascaded mode.
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Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum
extent permitted by applicable law: (1) Materials are made available AS IS and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES
AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort,
including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in
connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss
or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party)
even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no
obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not
reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and
conditions of Xilinx’s limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP
cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or
intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products
in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos,

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS,
THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A
SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING
LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2012-2020 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Zyng, and other designated brands included herein
are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.
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